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The Falcon030

Introduction
Congratulations on the purchase of your Atari computer. The Falcon030 is a
state-of-the-art personal computer, offering uncompromised performance and
affordability. Combining a fast microprocessor architecture with digital signal
processing and true-color graphics capabilities, the Falcon030 is an ideal platform
for today's applications, such as multimedia, desktop publishing, graphic arts,
games, and educational software.
Your Falcon030 is available with the following standard features and options.

Standard Features
16MHz 68030 microprocessor
32MHz Motorola 56001 Digital Signal Processor (DSP)
lMB, 4MB, or 14MB of Random Access Memory (RAM)
Video color palette of 262,144 (65,536 sin?ultaneous) colors
1.44MB PC-compatible internal floppy diskette drive
An array of ports which include: SCSI, RS232, Parallel, RF, Video, MIDI,
Cartridge, L,AN, Microphone, Headphone, Joystick (expanded), and DSP
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The Atari MultiTOS pre-emptive multitasking operating environment
A control panel that allows you to customize the different features of your
desktop
A sophisticated desktop that displays your favorite executable files as
smart icons, wbich you can link to a directory, resource files, and custom
setups

Options
16MHz 6888112 Floating Point Unit (FPU)
Internal hard disk drive

Using This Manual
This manual is divided into several parts, which explain in clear, nontechnical
language how to use your computer and its operating environment. After you
become more familiar with your computer, this manual will continue to be a
helpful guide for individual procedures and specific information. Below is
summary of the manual's contents.

Part I: Getting Started
Chapter 1, The Falcon030, provides a list of your computer's standard features,
and available options. This chapter also gives you simple directions for setting up
the computer and connecting peripherals.
Chapter 2, Using Your Computer, explains a number of fundamental concepts,
which help you understand how a computer works. This chapter
also introduces you to the keyboard, mouse, and floppy disk drive.
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Part II: Using the Desktop
Chapter 3, The GEM-Desktop, teaches you how to do basic tasks on the
desktop, such as moving the cursor and working with windows.
Chapter 4, A Guided 'Tour of the Desktop, introduces you to all the desktop's
menus, commands, and features. This chapter also explains how to customize
your desktop environment using the Control Panel and its various CPX modules.
Chapter 5, Desktop Management, teaches you how to work with directories,
folders, and files. This chapter also tells you how to develop and maintain an
efficient desktop environment.
Chapter 6, Advanced Desktop Features, introduces you to MultiTOS, your
computer's advanced pre-emptive multitasking environment.

Part Ill: Appendixes, Glossary, and Index
Appendix A, Cursor Control Quick Reference, describes the cursor actions that
you can control using the mouse or keyboard.
Appendix B, Advanced Hard Disk Utilities, describes the features of the
Advanced Ilard Disk Utilities (HDX) program.
Appendix C, Troubleshooting and Maintenance, offers solutions to problems
you may encounter while setting up or operating your computer. This appendix
also provides guidelines for proper maintenance of your system.
Appendix D, S~ecifications,summarizes your system's major features and
requirements.

The Falcon030 1-3

Fa1con038 Owner's Manual
Appendix E, Connector Specifications, gives specifications for the various
ports and connectors on the system.
Appendix F, Customer Support, tells you where to find more information
about your Atari computer and other Atari computer products.
Glossary defines common technical terms used in this manual as they relate
to your computer.
Index helps you locate terms and procedures used or explained in the
manual.

Special Notations
This manual uses special notations to communicate information efficiently.
Following are examples of the special notations as they appear throughout
this manual.
Characters enclosed in square brackets ([ 1) represent keys on the keyboard.
For example, when this guide instructs you to press [Return], you should
press the Return key on the keyboard.
When a procedure requires you to use two or more keys at the same time, the
keys are grouped together (e.g., [Control] [XI).
Notes: These contain useful hints and other information relevant to the topic
being discussed.

Cautions: These alert you to potential problems and suggest ways to avoid
those problems.
Filenames are capitalized. For example, the NEWDESK.INF and
DESKICN.RSC files are located on your computer's Language disk.
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Part and chapter titles are enclosed in quotation marks and/or appear in boldface type (e.g., Chapter 1, The Falcon030, and Part I: Getting Started).
Selectable items appear in a different font than standard text. For example,
desktop commands, such as Open, Cancel, and OK.

Setting Up Your System
Setting up the Falcon030 is easy. Use the information in this section to set up
your system and any peripheral devices.

Preparing a Workspace
Before going any further, take a moment to prepare a workspace for your
computer. Start by finding a flat, stable surface area near an electrical outlet.
The surface area should be able to support the weight of the computer, and
any device that you want to connecting to it. Be sure to protect the system
from dust, grease, extreme temperatures, prolonged exposure to direct
sunlight, and high humidity. Use a surge protector to protect the computer
against damage caused by abnormal flows of electricity.

Connecting the Mouse
Note: W e recommend that you purchase a mouse pad to use with your Atar-i
mouse. A mouse pad provides a clean, even surface that prevents dust and dirt
from collecting inside the mouse.

The Falcon030 1-5

There is a 9-pin plug with two rows of holes on the end of the mouse cord. This
plug fits into the joystick/mouse port in one dhection only, so you don't need to
worry about making a wrong connection.
The mouse connects to the system through the joystick/mouse port, which is one
of two ports located underneath the keyboard. (The other port underneath the
keyboard is a dedicated joystick port.) You can identify the mouse port by its
icon located on the bottom of the keyboard.

Connecting the Monitor
Since there are a variety of monitors available for use with the Falcon030, you
should consult the setup instructions that come with your particular monitor.

The Monitor Adapter Block
Before you can use a monitor with the Falcon030, you need to purchase the
correct monitor adapter block. The monitor adapter block allows you to use a
variety of monitors with the Falcon030. The monitor block is easy to use.
Connect one end of the block to the monitor's video adapter cable and the other
end to the Video port. For more information about the monitor adapter block,
contact an Atari dealer.

Connecting the Power Cable
After you connect the monitor and mouse, use the following instructions to
connect the power cable.
1. Connect the power cable's female end to the three-pronged socket on the back of the
system.

2. Plug the power cable's male end into a power source, such as a surge protector
plugged into a power outlet.
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Starting your System
Now that you've connected the monitor, mouse, and power cord, you're ready to
start (or boot) your system. The term boot comes from the word hootsti.ap.
Bootstraps allow you to pull on a boot, just like booting a computer allows you to
start your computer's operating system (more on this later).
The ROM chips inside your computer contain the operating system, so you don't
need a system disk to start your computer (see Chapter 2,Using Your Computer
for more information). Although, you can have the computer to read additional
startup information, such as the desktop files, from a disk.
You can store startup information on a hard disk or a floppy disk, such as the
Language disk that comes with the computer. In either case, if the startup files are
available, the computer reads them during bootup.
Note: If you want to learn more about your computer before going further, skip to
Chapter 2, Using your Computer, then return to this section when you are ready
to start the system.
The following sections tell you how to boot up your computer. If you want to
connect a printer, external drive, or another peripheral device to your computer
now, read Connecting a Peripheral Device (later in this chapter), before going
any further. If you are not connecting any devices, use the following information
to boot up your computer.

Starting from a Hard Disk
Your hard disk contains files which allow it to boot up the operating system and
display the desktop.
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Use the following steps to boot up from the hard disk:
1. Switch on any peripherals attached to the system.

2. Switch on the computer and the monitor.
While the computer is starting the operating system and checking the system
memory, you'll see the Atari logo on the upper left portion of the screen. You will
also see a bar displayed across the screen. When the system completes the
memory test, the bar starts to shrink. The startup process waits for the bar to
shrink completely before going on. This provides a necessary timeout for some
external peripherals. If there are no external peripherals attached to the computer,
press any key to abort the time out. Afterwards, the system displays the desktop.

Note: If the computer cannot find the neededfiles 011 the hard disk durirzg bootup, it
loads the default desktop, which does not display any hard disk icons. If this occurs,
shut off the computer, then switch it on. If the hard disk icons still fail to appear on
the desktop, see Appendix C, Troubleshooting and Maintenance.

Starting from a Floppy Disk
If your system doesn't contain a hard disk, you'll want to boot the system with a
copy of the Language disk in drive A. The Language disk contains files that the
computer reads when it starts the operating system. For example, the Language
disk contains DESKICON.RSC, the icon resource file, and NEWDESK.INF,
which allows you to customize the layout of the desktop area.

Note: As a precaution you should make a working copy of the Langliuge disk. Use
the working copy instead of the o1.igiiza1disk. See Copying Files and Folders irz
Chapter 5, Desktop Management, for information on copying disks.

Use the following steps to boot up your system from a floppy startup disk:
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1. With the computer turned off, insert the working copy of the Language disk into
drive A.

2. Switch on any peripherals attached to the system.
3. Switch on the system.
Note: If you are booting the computer from the Language disk and the desktop fails
to appear, shut down the computer. Make sure the disk is correctly inserted in drive
A, and all cables are properly and securely connected. Start the system again. I f the
desktop still fails to appear, see Appendix C, Troubleshooting and Maintenance.

Connecting Peripheral Devices
Peripheral devices (e.g., printers, external hard disks, etc.) announce their
presence to the computer by sending electronic signals. In some cases, peripheral
devices share memory with the computer. In general, you should connect and
switch on all peripheral devices before booting up your computer. Using this
procedure ensures that all the connected peripheral devices initialize properly.
See Precautions in the following section for more information on connecting
peripheral devices.

Connecting a SCSI Device
The SCSI (pronounced scuzzy) data transfer protocol is popular among peripheral
manufacturers and is employed by many different types of devices.
Use the following steps to connect a SCSI device:
1. Shut down the computer and all peripherals.

2. Connect one end of the SCSI device's interface cable to the port labeled SCSI I1 on
the back panel of the computer.

3. Connect the other end of the interface cable to the port on the SCSI device.
Note: The cable required may differ fi-om peripheral to peripheral. Make
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sure you have the right cable.

4. Connect the power cable to the power jack on the back of the device.
5. Insert the three-pronged plug into a grounded wall outlet or power strip.

6. Set the SCSI ID Switch according to the following guidelines:
a) If the device is a hard disk, it MUST be set to 0. Other hard disks (if present)
MUST be set in sequence (e.g., 0 , 1, 2, 3, etc.). No two hard disks can have the
same setting.
b) If you are using other devices with a hard disk, use the directions above to set the
hard disk, skip a number, then set the remaining device(s) in sequence (e.g., 0 , 1, 2,
3, [ I, 5 , 6 7 ) .
c) If there are no hard disks in the daisy-chain (more on this later), start at 0 and set
any additional devices in sequence.

Note: Always read the documentation accompanying your SCSI device, 01.software,
before you set the SCSl ID switch.

Daisy-chaining is a way to connect more than one peripheral device to a single
port. The first device in the chdin connects to the computer, and the rest of the
devices in the chain connect to each other. For example, device A would connect
to the computer, device B would connect to device A. If you are daisy-chaining a
device to the Falcon030, see the manual supplied with the device for more
detailed information.

Precautions
Be sure to observe the following precautions when using any SCSI device with
your computer.
Always switch on the SCSI device before switching on the computer
Disconnect the SCSI device from the computer, before attempting any
modifications to the device.
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System Orientation
This guide makes frequent references to various system components and features.
Taking a few minutes to familiarize yourself with the layout of your system will
save you time when using your computer and this manual.

Front Panel
Following is an illustration and description of the features on the front panel of

Figure I - I . The Front Panel

--

Standard keyboard with function keys and numeric keypad
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Mouse port, underneath the keyboard, connects Atari mouse.
(The Mouse port is not visible in Figure 1- 1.)

Right Side Panel
Following is an illustration and description of the features on the right side panel.

\

Figure 1-2. The Right Side Panel

-- 1.44MB PC-compatible high-density floppy disk drive
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Rear Panel
Following is an illustration and brief description of the features visible on the rear
panel.
DSP

Microphone

Video

Headphone SCSI II

Printer

TV

Power Switch

Modem

LAN

Power Jack

Reset Button

Figure 1-3. The Rear Panel

-- Digital Signal Processing (DSP) port provides an interface to the digital audio
chips and the internal DSP for direct input/output of high-speed digital
signals.

-

Headphone: Mini-stereo output jack connects headphones or external speakers
for sound output.

-- Microphone: Mini-stereo input accepts a signal from a microphone, or a stereo
system.
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-- SCSI I1 port with DMA connects SCSI devices to the system.

-- TV (RF modulator) plug allows you to connect the computer to a TV set.
-- Video port connects a variety of monitor types.
=-

Printer (parallel) port connects printers, scanners, or other parallel devices.

-- Modem (RS232C) port connects a modem or another serial device.
LAN high-speed LocalTalk-calcompatible port allows you to network your
Falcon030 with other computers.

-

Power switch turns on the power to the system.

--Power jack connects the power cord.
-- Reset switch cold-boots the system when depressed.

Left Side Panel
The following is an illustration and description of the features on the left side
panel.
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Part f: Getting Started
MIDI Ports

Cartridge Slot

Joystick Ports

MIDI In and MIDI OuttThru ports connect other MIDI devices to the
computer. (For more information on MIDI see the following Note.)
Cartridge slot accepts program cards, hardware interfaces, etc. The system
recognizes the cartridge slot as drive C.
Joystick ports (2) connect a joystick to the computer.
Note: Musical Instrument Digital Interface or MIDlports allow you to connect
your system with other MIDI devices, such as electronic keyboards, sophisticated
tape recorders and a host of other electronic devices that communicate using the
MIDI standard.
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2Using Your Computer
Learning The Fundamentals
This section is designed to teach you about basic computer-related concepts and
technologies. More avanced computer users may wish to skip this section and go
directly to Part 11: Using the Desktop.

How a Computer Works
A computer processes instructions to perform a task. Two examples of
instructions are the operating system instructions on your computer's Read Only
Memory (ROM) chip, and the instructions in an executable program contained on
a disk. Your computer receives these instructions as electronic signals which it
then stores as data. The processing and storing of data (sets,of electronic signals
grouped together) is handled by a system of electronic components and integrated
circuits.

Memory
A computer's memory capacity is measured in bytes. Computer language is based
on the binary number system; the smallest data unit is one BInary digiT, or BIT.
Groups of 8 bits are called bytes. A kilobyte is 1,024 bytes; a megabyte is 1,024
kilobytes.

Using Your Computer
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Your computer uses two types of memory, system memory and storage memory.

System Memory
System memory consists of microchips inside your computer. The computer uses
system memory as a temporary work area in which to load and run programs, and
a way of storing important information, so that it can be accessed quickly.
There are two types of system memory, Read Only Memory( ROM) and Random
Access Memory (RAM).
You cannot write information into a ROM storage area. The information in ROM
is permanent, and cannot be erased. ROM chips inside your computer contain
operating system information.
Random Access Memory (RAM), consists of memory chips inside your computer
that store data while the computer is running. When you-turn off the computer, all
the information in RAM is erased. RAM is the computer's chalkboard. The
computer can quickly and efficiently access programs and data files written into
RAM. To permanently save information stored in RAM, you must transfer the
information from RAM into storage memory.

Storage Memory
Storage memory is located on storage devices. These devices include floppy
disks, standard hard disks, hard disks in removable cartridges, and CD-ROM
discs.

Hard Disks
Because of the hard disk's high storage capacity and fast access time, many
programs prefer to run off a hard disk.
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The Falcon030 is available with an optional internal hard disk, which is ready to
work, as soon as you boot up the system.
The hard disk is divided into partitions, which appear on the desktop as drive
icons (See Desktop Elements in Part 11: Using the Desktop, Chapter 3, The
GEM-Desktop, for more information on drive icons.) Partitions store
information independently although they are not physically separate devices.

Floppy Disks
Floppy disks store programs and the information you create (data). Floppy disks
store different amounts of data depending on the type of floppy disk; single-sided
floppy disks store 357,376 bytes, double-sided floppy disks store 726,016 bytes,
and high-density floppy disks store 1,458,176 bytes of data. Information on a
floppy disk is read from the disk into RAM, modified if desired, and later saved
back to the disk from RAM.
Your computer's 3.5 inch 1.44MB drive uses 3.5 inch high-density, double
density, or single-sided diskettes. Each diskette consists of a 3.5 inch rectangular
plastic casing holding a circular sheet (disk) of coated material. This material is
the magnetic media which holds the data read by the disk drive. Its accessible
section is protected by a sliding metal sleeve. Most floppy disks also have a
write-protect sliding tab. (For information on floppy disks, see The Floppy Disk
Drive later in this chapter.)

CD-ROM Discs
CD-ROM discs store information that can be read into RAM for processing.
Because CD-ROM disks use a read-only format, you cannot write any additional
data onto a CD-ROM disc.

Using Your Computer
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Operating System
Every computer needs an operating system to carry out even the most basic
functions. For example, TOS (your computer's operating system) controls the
way your computer handles tasks like reading from and writing to disks,
translating mouse movement into on-screen cursor movement, and displaying
information on the screen.

Graphics Environment Manager
The Graphics Environment Manager (GEM), is an important part of TOS. GEM
provides a graphic interface for the computer. This allows a screen display of
information as graphic images (e.g., picture icons and windows), as well as
letters, numbers, and symbols. For information on TOS, see Part 11: Using the
Desktop.

Getting Acquainted with Your
Computer
-

After your computer is running and displaying the desktop, you'll probably
wonder what to do next. Use the information contained in this section to get
better acquainted with various parts of your computer system.

The Screen Display-GEM Desktop
When you start your system, the computer reads the startup information from the
hard disk or the startup floppy disk and loads that information into RAM.
Afterwards, the desktop appears on your screen.
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The GEM Desktop is the starting point for almost everything you do with the
computer. The basic desktop contains two floppy disk icons, four hard disk icons
(if you have a hard disk), and a trash can icon on the left edge of the screen, a
menu bar at the top of the screen, and a pointer. (The second floppy icon is for
help in copying operations.) For more information on the Desktop, see Part 11:
Using the Desktop.

The Mouse
The mouse allows you control the movement of the pointer. Using the mouse, you
can position the pointer anywhere on the desktop.

How the Mouse Works
The mouse consists of several basic parts. The housing, which contains the mouse
components, has two buttons on top. These buttons are referred to as the left and
right mouse buttons. The mouse ball inside the mouse rolls when you move the
mouse. The movement of the mouse ball is translated into the movement of the
cursor by motion serzso1.s inside the housing. For more information on the mouse,
see Using the Mouse in Part 11: Using the Desktop, Chapter 3, The GEMDesktop.

The Keyboard
The computer 94-key keyboard is similar to a conventional typewriter keyboard
in its basic design and function. For example, [Return] acts like the carriage
return lever (or key) on a typewriter. Pressing [Return] moves the cursor down
the screen.
Most keys automatically repeat when held down. (For information on changing
the rate of automatic repeat, see Control Panel in Part 11: Using the Desktop,
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Chapter 4, A Guided Tour of the Desktop.

Figure 2-1. The Keyboard

The alphanumeric keys (letters, numbers, and symbols) have the same function as
similar keys on a typewriter. For example, pressing [S] produces s and pressing
[Shift] [S] produces S. Pressing [Caps Lock] toggles (switches back and forth)
between upper and lower case letters.
There are several keys on the computer's keyboard that perform special functions
not found on a typewriter.
For example, you can use [Control], [Alt], and [Shift] in conjunction with some
other key to produce a secondary function or code. To do so, you hold down one
or more of these keys while pressing the other key (like using SHIFT on a
typewriter).
Along the top of the keyboard are ten function keys labeled F1 through F10.
Software applications often assign special functions to these keys.
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The four arrow keys move the cursor in the direction indicated by the arrow. The
cursor is a movable graphic screen symbol (often an arrow, block, or vertical
line) that marks where the next action takes place.

Note: The presence o f a text cursor indicates that the computer is ready for you to
type somethirzg.
The numeric keypad is an alternate method for entering numbers and math
symbols, producing the same effect as typing the number or symbol from the
keyboard. [Enter] acts as [Return].

The Floppy Disk Drive
Your computer's high-density floppy disk drive is format-compatible with MSDOS version 3.2 and later. This section teaches you how to use the floppy disk
drive.

Formatting a Floppy Disk
You must format a new floppy disk before you can store programs and data on
the disk. Formatting prepares a floppy disk by completely erasing the disk's
contents, checking for damage to the magnetic media, and setting patterns in
place to hold information.
Floppy disks formatted by your computer are format compatible with MS-DOS
computers. This means information written to a floppy disk formatted on your
computer can be read by MS-DOS computers and vice versa.
The Falcon030's high-density floppy disk drive can use high-density, doublesided, or single-sided disks. However, a single-sided disk should not be formatted
as double-sided disk, and a double-sided disk should not be formatted as high-
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density disk. Disks used for densities or storage beyond
their rating are not dependable.
You can reformat previously used floppy disks. Since formatting erases all
information on a disk, it is sometimes more efficient to reformat a floppy disk
than to delete all of a floppy disk's files. However, do not format a disk one way
and then reformat it a different way later.

Caution: Formatting a floppy disk permanently erases all information on the
disk. Before you format any floppy disk, be sure to copy any data you want to
save.
Use the following steps to format a disk.

1. Start the computer. After the screen displays the desktop, insert the floppy disk into
the floppy disk drive.

2. S e l e c t t h e Format Floppy Disk c o m m a n d f r o m t h e F i l e m e n u . T h e
Copy/Format dialog box appears.

Note: Both the Copy and Format operations are combined in one dialog box
so you can format and then copy disks without returning to the desktop after
formatting. If you select the Format option and decide to copy a disk
instead, click on COPY. You can also click on FORMAT after initiating a
disk copy operation if you must format a diskfirst.

3. If you wish the disk to have a label, type in the label. Select a density setting,
depending on how you want to format the disk.

4. Select OK. The floppy disk drive begins formatting the disk. The indicator bar
displays formatting progress.

5. When the formatting is completed, an alert message displays the disks formatted
capacity in bytes.
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Caution: If the formatted disk does not have a reported capacity of
1,458,176 bytes (high-density), 726,016 bytes (double-sided),or 357,376
bytes (single-sided),the disk may be defective. If this is the case, try
formatting the disk again. If the problem persists, discard the bad disk and
use another disk.

6. T o return to the desktop, select Cancel. O r repeat the formatting process with
another blank, unforrnatted floppy disk.

Note: If you try to use a disk without first formatting it, the computer
displays an alert box. The alert box tells you that the disk drive is not
responding, and to please check the disk drive, or insert a correctly
formatted disk into the drive. Then you must select Retry (with a formatted
disk) or Cancel to tell the drive whether or not to attempt to read that disk.

Write-Protecting a Floppy Disk
Write-protecting a floppy disk prevents information from stored on the magnetic
media.
Most floppy disks have a small write-protect tab in their plastic casing. You
cannot write to, format, or erase a write-protected disk. It is a good idea to writeprotect disks containing important information so you do not inadvertently erase
information from the disk, especially when copying disks with a one-drive
system. You can move the write-protect tab back to the unprotected position at
any time.
Note: Some commercial program disks may not have write-protect tabs. These
disks are permanently write-protected and do not have tabs.
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The GEM Desktop

Basic Desktop Skills
Using the Desktop is easy. The following information and tutorials will help
familiarize you with the elements of the desktop. Readers already familiar with
TOS's basic desktop applications may wish to skip directly to Chapter 4, A
Guided Tour of the Desktop.
Most of the basic desktop tasks, such as selecting an item, or opening a window,
etc., are easiest to accomplish when using the mouse. If you are not currently
using a mouse, see Controlling the Pointer Using Keystroke Combinations,
later in this chapter. Afterwards, return to this section and substitute the
references to the mouse with the appropriate keystroke combinations.
Note: Before going any further place the Language disk, or your working copy of
the Language disk, in drive A.

Using the Mouse
Using the mouse, you can move the pointer anywhere on the desktop. In addition
to moving the pointer, the mouse allows you to do basic desktop tasks, such as
selecting, moving, and copying.
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Holding the Mouse
Place your hand over the mouse. Gently grasp the mouse between your thumb and
outer fingers. If you're left-handed, you'll probably want to rest your middle
finger on the left mouse button. If you are right handed, your index finger should
rest on the left mouse button. If neither of these positions
feels right, then choose a position that is comfortable for you.
There are several techniques involved in using the mouse. By mastering these few
simple techniques, you can easily do basic desktop tasks.

Moving the Pointer
The first basic task you need to learn is how to move the pointer. Moving the
pointer is easy. Just move the mouse and the pointer will follow. You'll find that
you can move the pointer across the entire screen by rolling the mouse over a
small surface area.

Selecting
Selecting an item tells the computer you want to use the it. When an item is
selected it highlights, which means it displays on the desktop in different colors
from your normal desktop colors. You can select one item or a group of items.
Both procedures are discussed in the sections that follow.
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Selecting an Icon
There are two types of icons: desktop icons and window icons. Desktop icons
include floppy and hard disk drive icons, printer and cartridge icons, and the trash
can icon. Window icons include folder and file icons (which can be displayed as
either text or icons).
Take a moment to practice selecting an icon. Move the pointer over the drive A
icon. Then, click the left mouse button once (this is called single-clicking). If
you've done it right, the drive A icon is selected, and appears highlighted. Move
the pointer away from the icon, and click on an empty area on the desktop to
deselect the icon.

Single-clicking and Double-clicking
Single-clicking selects and highlights. You have already used single-clicking to
highlight the drive A icon. Double-clicking combines two single-click actions in
quick succession to both select and start a process, such as opening a file or
directory.
Note: Use the Corztrol Panel to adjust the responsiveness of the left nnzouse b~ltton
to your clicking speed. For more information, refer to Control Panel in Chapter
4, A Guided Tour of the Desktop.
Now practice double-clicking. Move the pointer over the drive A icon. Doubleclick on the icon and the drive A directory appears in a window on the screen. To
close the directory, click on the Close button in the upper left corner of the
window. For more information on the Close button, see Windows, later in this
chapter.

Dragging
Dragging with the mouse is easy. All you need to do is select an item and move
the mouse while holding down the left mouse button. The selected objectcs)
follow the movement of the mouse.
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When you've dragged the objects to the desired location, release the left mouse
button to end the process. You need to drag to perform copy, move, or delete
operations.
If you drag a file icon or icons to a new destination and release the left mouse
button, the associated file or files will be copied, moved, or deleted, depending
on the operation performed.

Dragging an Icon
When you drag icons from one location to another, a ghost outline of all selected
icons follows the pointer from the original location to the destination. The pointer
shape also changes from a pointer to an outline of a hand until you release the left
mouse button.
Practice dragging an icon now by moving the desktop icons into different
configurations. If you accidentally drag one icon on top of another icon, a special
window called a dialog box will display. Select Cancel. The dialog box
disappears, and the moved icon returns to the position it occupied before you
moved it.

Selecting Multiple Icons
Sometimes you want to select more than one icon at a time to perform delete,
copy, move, or other operations. There are two ways to select multiple icons.
The first way is using the rubber-band box to select icons that are grouped
together on the desktop or in a window.
Use the pointer to create a box on the screen around the icons you wish to select.
The box is called a rubber-band box, because it expands or contracts when you
drag the pointer.
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You can use shift-clicking to select multiple icons individually instead of having
to select items that are physically grouped together. The selected icons do not
have to be in sequence on a list, or near each other on the desktop. Both methods
of selecting multiple icons can be used on desktop or window icons.

Using the Rubber-band Box
Whenever you drag the pointer, a rubber-band box appears on the screen. The
first corner of the rubber-band box is created wherever the pointer is positioned
on the screen. The box expands in the direction of pointer movement.
Follow these steps to practice selecting multiple icons with the rubber band box:
1. Position the pointer above and to the left of the drive A icon. Try not to touch the
nearby menu heading. If the menu drops down, just retract the menu and try again.

2. Now drag the pointer down and to the right. The rubber-band box appears and expands
with the pointer.

3. Surround the drive A and icon with the rubber-band box. Release the pointer. The icon
highlights.

4. Move the pointer to a clear area of the desktop and click the left mouse button to
deselect the icons.

Using Shift-clicking
Shift-clicking lets you select multiple items that are not next to each other on the
desktop, or in sequence in a window.
To practice selecting by shift-clicking, use the following steps to select the drive
A and B icons:
1. First, select the drive A icon.
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2. Now hold down [Shift] and position the pointer over the drive B icon. Click the left
tnouse button. Both the drive A and drive B icons are now highlighted.

Note: You must hold down [Shift] until all desired icons are selected. Once
you release [Shift], no further icons can be added to the selected group. If
you attempt to select a n icon after you release [Shift], all previously
selected icons will be deselected.

3. Move the pointer to a clear area of the desktop and click the left mouse button to
deselect the icons.

Combining Rubber-banding and Shift-clicking
You can combine rubber-banding and shift-clicking to select a group of icons,
then deselect any icons you don't want in the group.
Follow these steps to practice combining the two methods of selecting multiple
icons:
1. First, use rubber-banding to select both drive icons.

2. Now use shift-clicking to deselect the drive A icon. Only the drive B icon is
highlighted.

3. Use shift-clicking to reselect the drive A icon. Both icons are again highlighted.
4. Move the pointer to a clear area of the desktop and click the mouse button to deselect
the icons.

Controlling the Pointer with Keystroke
Combinations
You can control the pointer, move, select, copy, etc., using keystroke
combinations instead of the mouse.
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To use keystroke combinations, hold down the first key listed and press the
second key (or if three keys are listed, hold down the first two keys and press the
third key).
Note: Refer to Appendix A, Pointer Control and Quick Reference, for a quick
reference chart listing the keystrokes for controlling the pointer.

Moving the Pointer with Keystrokes
Your screen is divided into tiny sections or pixels. When you use keystroke
combinations to move the pointer, the pointer moves either one pixel at a time or
in multiple pixel jumps. [Alt] [Shift] combined with any arrow key moves the
pointer one pixel in the direction of the arrow. Use this combination for
fine positioning.

Selecting with Keystrokes
Using the keystroke combination [Alt] [Insert] performs the same function as
clicking the left mouse button. To perform a keystroke double-click, hold down
[Alt] and quickly press [Insert] twice.
Follow these instructions to practice selecting and initiating a procedure using
keystroke combinations:
1. Position the pointer over the drive A icon.

2. Press [Alt] [Insert]. The drive A icon highlights. You have selected the drive A icon.
Now move the pointer to an open area of the desktop and press [Alt] [Insert] again to
deselect the drive A icon.

3. To practice keystroke double clicking (selecting and opening the drive A window in
one maneuver), reposition the pointer over the drive A icon. Hold down [Alt] and
quickly press [Insert] twice. A window opens and displays the contents of the disk in
drive A.
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4. To close the open window, position the pointer over the small box in the upper left hand
corner of the window and press [Alt] [Insert]. The window closes.

Dragging with Keystrokes
To drag with keystroke combinations, press [Alt] [Insert] combined with any
arrow key to drag a selected icon or group of icons in the direction of the arrow.
The pointer must be positioned over the selected icon or group of icons for
successful dragging.

Windows
Most of the desktop activity takes place in windows. Windows are small screens
within the larger screen display. There are two types of windows, general
program windows and desktop windows. The basic difference is that desktop
windows display more information than general windows. Figure 3-1, below, is
an example of a desktop window.
Drive Identifier

File Mask

Close Button

Full Button

Information Line
Resize Button

\/
Scroll Bars

Figure 3-1. Window Elements
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The Drive Iderztifier appears in the center of a window's move bar. It shows the
drive letter of the open drive, in this case hard disk drive C.

The File Mask tells you what type of files are displayed in the window. You can
set the File Mask to display all the files in a directory, or you can set up
restrictions on the types of files displayed. The window displays an icon for each
folder in the directory, and for every file in the directory that matches the file
mask setting. For more detailed information on setting the File Mask, see Set File
Mask in Chapter 4, A Guided Tour of the Desktop.
The I~ZformationLine displays the Bytes Used (total number of bytes of disk
space used by the contents of the directory), and Items (the number of files and
folders residing within the directory). If some items are selected, the numbers
refer only to the selected items. The other elements of a window are explained in
the following tutorial sections.
On the right and bottom sides of the window there are scroll bars that allow you
to view portions of the windows contents, when all of the contents are not visible.
There are several buttons for controlling the window. The Close button closes the
window when you click on it. The Full button resizes the window so that it uses
the full screen. The Resize butt011 allows you to drag a window to size.

Opening and Closing a Window
Directory windows can be opened in several ways by using the pointer and left
mouse button. You can practice opening a window now. First, make sure the
Language disk is in drive A, then double click on the drive A icon.
You have opened a window by double clicking on a desktop icon. The contents of
the Language disk now appear in the drive A directory window.
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Note: If the drive A icon highlights but the window does not open, the computer
has not recognized your click as a double-click, but only as a single-click. Move
the pointer to a clear area of the desktop and click once to deselect fhe icon. Try
again, and remember that double clicking can be u bit tricky at first. Just keep
practicing.
Leave the drive A directory window open for now; you will use it in the next
exercise.

Scrolling a Window
Sometimes a single directory contains too many items to display in a window at
one time. When this occurs, some directory items remain undisplayed, or hidden.
You can view the hidden items by using the scroll bars.
The scroll bars along the bottom and right edges of the window let you scroll the
window horizontally (right and left) or vertically (up and down).
If a directory contains more items than will fit in the window, a portion of the
scroll bar will be shaded. The scroll box shows the current position and size of
the window relative to the total directory display. If there is shaded area above or
below the scroll box, more of the directory is available by scrolling the window
in the direction of the shaded area.

Practice scrolling a window. Use the drive A directory window that is still open.
For this exercise, use the scroll bars to find LINES.PRG, a program that you will
be using in the next exercise.
Scroll by positioning the pointer over the scroll arrow that indicates the direction
of the hidden contents. Click once. Now click once on the opposite arrow to
return to the original window display. The contents of the window scroll by one
space.
Now scroll, one window display at a time, by positioning the pointer over the
shaded area of the scroll bar. Click once. The previously displayed items are now
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hidden, and the screen displays previously hidden items.
Note: You can also scroll using the up and down a r r o ~ keys
i
to the right of the
main key hoard.
Try scrolling entries continuously by positioning the pointer over the scroll arrow
that indicates hidden items. Hold down the left mouse button.
Note: You can also skip over some of a directory's contents by dragging the
scroll box to a new position in the scroll bar. The window now displays the
contents of that portion of the directory.
When you have found LINES.PRG, leave the window open and go on to the next
exercise.

Sizing a Window
Sizing a window is especially useful when you want to display more than one
window on the desktop at a time. Practice sizing a window by first opening the
program LINES.PRG using the techniques you have already learned.
The Lines program displays a group of lines moving across the screen. When you
open LINES.PRG it uses the full window. So you can practice resizing a window
by reducing the size of the Lines window.
First find the size box in the lower right corner of the window. Move the pointer
over the size box and use dragging to move the size box up and to the left. An
outline of the window follows the pointer movement. Release the left mouse
button when the window outline is about half of the original window size.
Then locate and select the Full button in the upper right corner of the screen.
Selecting the full box expands a window to fill the entire screen.
Just for fun, take a moment to explore the Lines program. Press [Clr Home] and
you will see the group of lines reduced to a single object. The lines are now
erasing themselves as they go along. Pressing [Clr Home] toggles the erase mode
on and off.
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You can increase or decrease the line segments of the object by pressing a
number key on the keypad. Try pressing the number keys until you find a shape
that you like.
There are other ways of controlling the Lines program, which you will learn
about later.
If you select the Full box again. The window returns to the most recent size and
position. Continue to practice sizing the window. Drag the size box down towards
the bottom of the screen to lengthen the window, up to shorten the window, right
to widen it, or left to narrow it. When you have finished practicing, leave the
window open for the next exercise.

Moving a Window
You can use the move bar to move a window to any screen position below the
menu bar.
First, position the pointer over the shaded move bar. Drag the window to a new
position on the screen, then release the mouse button. The window displays in its
new position.
Let's work with the Lines program some more. Start with the shape you made in
the previous exercise. Now add more shapes by pressing [*I on the keypad. If you
want fewer shapes press [/I. Finally, press [+I to bring the shapes closer together,
or press [-I to split the shapes further apart. Press [Clr Home] if you want Lines
to erase the lines as they move along. When you're done, close the Lines window
by clicking on the Close box.

The Top Window
When you have more than one window open at a time, the window in front is the
top window. You can identify which window is the top window by looking at the
move bar. Only the top window's move bar is shaded.

3-12 The GEM Desktop

Make any window the top window by positioning the pointer anywhere on the
window and clicking the left mouse button.
Open windows may overlap. If they do, the top window is always completely
displayed. Top a partly hidden, bottom window by positioning the pointer
anywhere on the window and clicking the left mouse button. The bottom window
moves to the front of the other windows.

Menus and Pop-ups
Menus and pop-ups allow you to select different options on the desktop or in the
Control Panel CPXs. Menus, which display a full range of choices, usually drop
down from the menu bar. If you select an item from a menu, a checkmark appears
beside the item. Pop-ups are smaller, more specific menus activated by buttons.

Opening a Menu
Each menu heading on the menu bar has its own drop-down menu. If you move
the pointer onto the menu bar near one of the headings that menu immediately
drops down and displays its command options. Moving the pointer away from the
dropped menu to another menu heading causes the new menu to drop down, and
the previously displayed menu to retract.
Note: A drop-down menu may have both a c t i ~ vand inactive options. Acti~le
options are in r.egular text and produce at? action when selected. Inactilv optior~s
appear as lightened text. Selecting an inacti~3eoption causes the menu to retract.
Optiorzs with a check nzark to the left of them a1.e currently selected.
To retract a menu without selecting a command option, move the pointer outside
the menu and click on the desktop.
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Opening a Pop-up
Pop-ups appear as shadowed buttons when closed, and menus when open.
To open a pop-up, click on a shadowed (pop-up) button with the mouse. A popup will appear with a list of selectable items. The currently selected item is
indicated by a checkmark. Clicking on any item selects that item. Clicking once
more on the selected item closes the pop-up. When you close a pop-up, the
current selection appears on the shadowed button.
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A Guided Tour of the Desktop

The Menu Bar
The top edge of the desktop contains the menu bar. The menu headings are Desk,
File, View, and Options. T o see the commands within any menu heading, position
the pointer over the menu heading. The heading highlights and the menu displays
under the selected heading.
When the menu displays you can select an option. Options in black text are active
and available for use. Options in light text are inactive. Inactive options are not
available for use at the time you display the menu. (See the specific option later
in this chapter for more information.)
Most of the commands listed under the menu headings can be selected by using a
single keystroke. Each command's keystroke is listed in brackets to the right of
the command name. To initiate the command, just press the key indicated. It
saves a lot of time if you memorize the keystrokes for the commands you use
frequently. You can change the assigned keystroke of a command, or assign a
keystroke to a command that does not have one. (Refer to Desktop
Configuration in this chapter.)

A Guided Tour of the Desktop 4-1

Desk Menu
The Desk menu is divided into sections of selectable menu items. The upper
section displays the name of the application you are currently using. Selecting
this menu item displays information about the application.
The lower section contains a list selectable menu items that allow you to access
desk accessories, such as the Control Panel.

Note: Desk accessories are automatically loaded each time you start up the
system. Sulitclzirzg olz the computer without active desk accessories frees sonze
RAM and displays the desktop faster.
Following is a detailed description of the different sections of the Desk menu:

Desktop Info
When you display the Desk menu from the desktop, the top section of the menu
lists the Desktop Info option. If you select Desktop Info, a window listing GEM
and MultiTOS copyright data displays.

Control Panel
The Control Panel accessory (XCONTROL.ACC) allows you to modify your
system's setup even while your working inside another program. For detailed
information on the Control Panel, see Control Panel in Desk accessories, later
in this chapter.
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File Menu
The File menu contains options for opening and closing directory windows,
selecting all displayed files and folders for an operation, deleting a file or folder,
creating a folder, formatting disks, and more. This section explains in detail each
File menu option.

Open
The Open command can be performed on a disk icon, cartridge icon, folder, file,
or printer icon.
First select the item you wish to open. Then select Open from the File menu. The
result of the command depends upon which icon is highlighted:

Disk icon or folder The disk or folder directory window appears.
Cartridge icon (drive c) or executable file. The desktop disappears and the
program runs.
Printer icon An alert box, which informs you that the icon you attempted to
open is a printing device, appears.
Data file If you have installed an application that is linked to the
same document type as the data file you are opening, the application automatically opens and loads the data file. If no such application is installed, a
dialog box displays, giving you the choices Show, Print, or Cancel. Show
displays the contents of the file on the screen as ASCII characters. Print outputs
the contents of the file to a printer (if you have a printer connected
to your system), and Cancel cancels the command.
Note: AH alternative to using the Open menu command is to position the pointer
over the icon you wish to open and double-click the left mouse button.
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Show Information
When you highlight a floppy disk, logical drive, folder, or file icon and select the
Show lnfo option, the screen displays information about the highlighted item.
When you select Show lnfo for a floppy disk or logical drive icon, the Disk
Information dialog box displays the following information:

Drive ID The drive's letter identifier.
Disk Label The name you assigned to the drive. (This field may be blank.)
Number of Folders The total number of folders on the disk or logical drive,
including folders within folders.
Number of Files T h e total number of files on the disk o r logical drive,
including files within folders.
Bytes used The number of bytes used by all files and folders on the disk or
logical drive.
Bytes available The available storage space (measured in bytes) left on the
disk.
Note: In the Disk l~zfomationdialog box, the number of bytes usedplus the
number of bytes available for a floppy disk or logical drive does not always equal
the exact total storage capacity. This is because the computer allocates space for
each file in fixed-size blocks, even if the file does not completely fill the last
block. The Bytes Available information is an accurate indicator of available
unused storage space.
When you select Show lnfo for a file or folder, the File Information dialog box
or Folder Information dialog box displays the following information:
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Path The top line lists the complete path of the file or folder. If the path is too
long to display on the line, you can use the scroll arrows to reveal the hidden part
of the pathname.
Name The name of the folder or file. The text insertion cursor appears to the
right of the name.
To change the name of a file or folder, press [Esc] to clear the name line. Type in
the new name, using eight characters or less. Type a period, then the three
character file extension (usually not used in folder names).

Size Size, in bytes of the file or folder. Folder size is the total number of bytes
used by all the files within the folder.
Date The date the file or folder was last modified.
Time The time the file or folder was last modified.
Number of Folders The number of folders within the folder. This only applies
to folders.

Number of Files The total number of files within the folder, including files
within other folders.

Attribute The two choices are Read Only, and ReadJWrite. If you want
to make sure a file remains intact and no changes are made to it, select Read
Only. You will still be able to display and copy the file, but you cannot modify or
delete it. ReadJWrite allows you to read the file, change it, or delete it. The
Attribute field does not apply to folders.

The Search command performs a file search on a floppy disk, logical drive, or
folder. When you select Search, the Search File dialog box appears.
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You must set the parameters of the search by typing in the name of the file for
which you are searching. You can also type in part of a filename, and Search
matches the typed characters. For example, if you wish to search for all files with
the extension .DOC, type a period, then type DOC. Search opens the window
containing the first .DOC file it finds and asks you if it should continue the
search. If you select OK, Search will use the same window to show the next
.DOC file, and so on.
When Search can find no more .DOC files, an alert box displays to let you know
that no more files are to be found.
Before selecting Search, you should highlight the floppy disk, logical drive, or
folder upon which you wish the search performed. If no item is highlighted,
Search will perform the command upon the active window. If there is no open
window on the desktop and no highlighted item, you cannot select Search from
the menu.
Note: The Search dialog box may cover highlighted icons. Since the files found by
Search are highlighted, the window information line displays the number of
matches.

Delete
The Delete command deletes all highlighted files and folders. If you highlight a
floppy disk or logical drive icon and select Delete, all files and folders contained
on the corresponding drive will be deleted.

Create Folder
The Create Folder command creates a new folder in the active window. When
you select this command, the New Folder dialog box appears. Type in a name for
the folder, then select OK (or press [Return]). The name of the new folder
appears in the directory window.
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Note: Certain char.acters cannot be used within a folder rlame or extension.
For a list of illegal character.^, see Files and Filenames in Chapter 5, Desktop
Management.

Close Directory
The Close Directory command closes the top level of the active window. For
example, let's say the top window is a folder window, and that folder resides in
the main directory of drive C. When you select Close Directory, the folder's
window closes, and the main directory window displays.

Note: You can also close a directory by selectirzg the close box in the window's
upper left corner..

Close Top Window
The Close Top Window command completely closes the top window, including
all levels of folder windows and the main directory window. If windows from
other floppy disks or logical drives are open on the desktop, the most recently
opened window becomes the active window.

Bottom to Top
The Bottom to Top command is useful when you have multiple, overlapping
windo'ws displayed on the desktop. When you select this command, Bottom to
Top brings the bottom window to the top of the stack and displays it as the active
window. The current top window is sent to the bottom of the stack.

Select All Items
The Select All Items command selects all files and folders in the top window (see
Note). The files and folders that are hidden, but would be shown by scrolling, are
also selected. However, files that are in the directory but do not match the file
mask parameters are not selected. (See Set File Mask in this chapter.)
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Note: If the File Mask is
are selected.

*.* (show all items), then all items, including all folders,

Set File Mask
The Set File Mask command allows you to choose the file type to be displayed in
the active window. When you select this command, the Set File Mask dialog box
appears. You must fill in the file type parameters, both file name and file
extension.
For example, if you want only those files beginning with the letters DESK to
appear in the directory list, you would press escape to clear the Name line. Then
you would type DESK*.* and select OK. The first asterisk after the word DESK
means that any file with characters in the filename following the letters DESK
should be displayed. The asterisk is known as a wild card character. (See File
Specification in this chapter). The period is the separation between the filename
and the file extension. The second asterisk means any file with a filename that
meets the parameters should be displayed no matter what extension the file has.
Setting the file mask as described here would display files with different
filenames and extensions, such as DESKTOP.INF and DESKACC.DOC, as long
as the filename begins with the characters DESK.
The default file mask parameter is an asterisk for the filename and an asterisk for
the extension. This means all files are displayed.
Note: Although all folders are visible during afile mask, you can use afile mask
to select folders u'ith the same extension.
The parameters selected for the open window remain in effect as long as the
window remains open. Once you close the window, the parameters you chose are
cleared.
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Format Floppy Disk
Formatting prepares floppy disks to accept data. You can format disks as either
single-sided, double-sided, or high-density. Used disks can be reformatted.
All disks formatted with TOS are compatible with MS-DOS version 3.2 or later.
To format a floppy disk, insert the disk into a floppy disk drive. Select the floppy
disk icon, then select Format. For complete information on formatting disks, see
Formatting a Floppy Disk in Chapter 2, Using Your Computer.

View Menu
The View menu lets you choose the way your computer displays files and folders.
You can view files and folders as icons or text. You can display those filenames
alphabetically by name (filename or extension), or numerically by date or file
size. To modify the display, select the menu option yo11 want. A check next to a
option indicates that option is selected.
Options selected from the View menu affect all directory windows. You cannot
select one option for one window and a different option for another window.
Note: W h e n you save your desktop, TOS saves all the View nzenu choices you
made to the NEWDESK.INFfile on your start~lpdrive. (See Save Desktop in this
chapter-.)
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Show as Icons or Show as Text
The same directory, with entries displayed both as icons and as text, is shown in
the following example.
0I
c:\*,*
II
4 7 8 2 0 2 b y t e s used i n 47 i t e m s ,

Q

d
RuTo

GDOS .SVS

8
cpx

8:
6

H16LL

01

lo

c1w,*

36 b y t e s used i n 49 i t e m s ,
9UTO
18-04-91
:PX
18-04-91
iSPRIT
18-04-31
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SYS
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IDX
05-31-92
IIHSTRLL
85-31-92

I:i:
82159
02159
03181
12111
12120
12117
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am
am o

);

0 r;

Figure 4-1. Icons and Text

When directory entries are shown as icons, different icons indicate different types
of files or folders. The window displays icons in horizontal rows across the
desktop. You can choose the shape of desktop and window icons. See Install
Icon in this chapter.
When directory entries are shown as text, the window displays the filename, file
size, and the date and time the file was last modified. A square icon to the left of
a filename indicates a folder. The window displays files and folders as vertical
text.
Note: A triangle symbol appearing next to afile name indicates a read-only file.
Files and folders displayed as text may be opened, copied, and deleted using the
same procedure used with icons.

Sorting by NameIDatelSizeTType
It is sometimes necessary for you to have a list of your files and folders presented
in a certain order.
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Folders as a group are always listed first, followed by files (Except with the No
Sort Option). You can sort your files and folders in the following ways:

Sort by Name Displays files and folders alphabetically.
Sort by Date Displays files and folders chronologically. The most recently
created or revised file or folder appears first.
Sort by Type Lists files alphabetically according to their extension type. Files
with common extensions are grouped together in alphabetical order by filename.
Sort by Size List files in descending order according to their size.
NO sort List files and folders according to the order in which a program would
recognize them.

Size to Fit
When you select Size To Fit, all items are displayed in horizontal rows starting
at the top of the window. Each row is only as wide as the window and will
automatically rearrange whenever the window is resized.

Set Color and Style
Set color and style allows you to create a unique desktop environment. You can
use Set Color and Style to choose a color and/or fill pattern for both your desktop
and for opened windows. When you select Set Color and Style, the Set Color
and Style dialog box appears.
Note: To m o d i ! the window display, the Window box mustfirst be highlighted.
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To modify your desktop environment, follow these steps:
1. Highlight the Desktop box.

2. Position the pointer over the solid black Style square and click once.

3. To select a color, position your pointer over the desired color on the color palette and
click once. The color displays in the Preview Box. (If you are using a nlonochrome
monitor, position your pointer anywhere on the black section of the color palette and
click once.)

4. To select a fill pattern, position your pointer over the desired fill pattern and click
once. The fill pattern displays over the color in the Preview Box.

5. Next highlight the Window box and repeat Steps 2 through 4 to modify your window
display.

6. Select OK to select the chosen options and exit Set Color and Style.

Options Menu
The Options menu includes commands that allow you to save your desktop
configuration, install icons, applications, and devices, and print what is displayed
on your screen. You can use the Set Preferences option under the Options menu
to switch confirmation dialog boxes on or off and set your screen resolution.

Note: W h e n you save Y O U I . desktop,TOS saves ull the Options menu choices you
made to the NEWDESK INF file on your startup disk. (See Save Desktop in this
th
menu conznzands.
chapter.) Use Save Desktop to save chailges made ~ ~ i Options
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Install lcon
Install Icon allows you to choose the shape of your window and desktop icons.
The DESKICON.RSC file on your C drive or floppy startup disk contains a
collection of icon shapes. You access this file through Install Icon. Choose from a
variety of icons to create an interesting and entertaining desktop.
You can also use Install Icon to change a floppy disk's or logical drive's icon
identifier and icon label.
When you select Install lcon from the Options menu, the select icon type dialog
box displays. You can select either Desktop or Window. Desktop icons are:
device icons (printer, floppy disk drive, logical drive, and cartridge), and the trash
can icon. Window icons are folder and file icons.

Desktop lcon
To install a single desktop icon, follow these steps:
1. If you are installing a floppy disk or logical drive icon, type the drive identifier letter.
Press [Tab].

2. Type in the narne of the floppy disk or logical drive. You can use up to 12 characters.
This step is optional; you do not have to assign labels (names) to your desktop icons.

3. Position your pointer over the type of icon you wish to install: Drive, Trash Can, or
Printer (see Using an Installed Printer Icon later in this section). Click the left
lnouse button once.

4. Use the scroll arrows to scroll through your icon choices. When the desired icon
displays, select OK to install. The icon appears on your desktop.
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Use the following steps to assign an icon shape to a group of desktop items:
1. From the desktop, use rubber-banding and/or shift-clicking to highlight the group of
desktop items.

2. Select install Icon from the Options menu. The Install Desktop Icon dialog box
displays. The drive identifier, icon label, and currently assigned icon shape of the first
selected desktop item appears in the dialog box.

3. If the Drive box is not highlighted, position your pointer over the Drive box and click
the left mouse button once.

4. Use the scroll arrows to display the desired icon shape. T o assign that icon shape to
the first of the selected group of items, select OK. The second item of the selected
group displays in the dialog box.

Note: If you do not wish to assign a new icon shape to an iten? in the selected
group, select Skip when that item displays in the dialog box. That item retains its
current icon shape.
When you finish selecting the final item in the group, the dialog box disappears.
The new icons for all selected items appear on your desktop.

Window Icon
There are two ways in which a window displays items: text and icons. You can
assign icon shapes to window items that are currently displayed as text, but the
assigned icon shapes will not display until Show as Icons (under the View menu)
is selected.
You can assign icon shapes to: a single window item (file or folder), a group of
window items, or a specific file type.
To assign an icon shape to a single window item (file or folder), or a group of
window items, follow these steps:
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1. Open the window containing the desired window items. Highlight a single displayed
window item or use rubber-banding to highlight a group of displayed window items.

2. 'Select ltlstall Icon from the Options menu.
The Install Window Icons dialog box displays. The name of the first selected
desktop item appears in the dialog box. Either the File or Folder box is
highlighted, designating the type of item displayed, and the icon currently
assigned to the item is displayed.

3. Use the scroll arrows to scroll through your icon choices. When the desired icon
l assign the icon shape to the displayed item. The name of
displays, select l t l ~ t a lto
the selected group's second item displays in the dialog box, along with that item's
current icon.
Note: If you do not wish to assign a new icon shape to an item in the selected
group, select Skip when that item's name and current icon displays in the dialog
box. That item retains its current icon shape. If you wish to remove the item's
currently assigned icon shape, select Remove. The default icon shape for that
item type is automatically assigned to that item.
When you have completed the selection process for the final item in the selected
group, the dialog box disappears. The new icons for all selected items appear in
the window.
You can also assign an icon shape to a file type. After setting the parameters to
define the file type, all the files that match the selected parameters will be
assigned the specified icon shape. Select the parameters the same way you would
set a file mask, typing in the parameters on the Name line of the Install Window
Icons dialog box. (See Set File Mask in this chapter.)
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To assign an icon shape to a specific file extension, follow these steps:

1. With a window open, select l n ~ t a l Icon
l
from the Options menu. Select the
Window box from the dialog box. The Install Window Icons dialog box displays.

2. Type *, followed by the extension (for example, *.FNT).

3. Use the scroll arrows to display the desired icon shape. T o assign that icon shape to
the files matching the specified parameters, select Install. T h e dialog box
disappears. All files that match the selected parameters will be represented by the
selected icon.

Changing the lcon Identifier and Label
To enter a new icon identifier and label for an icon, follow these steps:

1. Highlight the icon you wish to change. Select l n ~ t a l Icon
l
from the Options menu.
The Install Icon dialog box appears.

2. Type the new Icon identifier letter and press [Tab]. If you wish to retain the current
drive identifier, press [Tab] to move the text insertion cursor to the Icon Label line.

Note: The letters A and B are reserved for floppy disks, and the lowercase
letter c is ~ . e s e ~ . ~ v dthe
f o rcartridge slot. Uplxrcase 1ettei.s C th~.oughP
represent logical drives.

3. Press [Esc] to clear the Icon Label line. Type in the new icon label. You can use up to
12 characters. Select OK.

Using an Installed Printer lcon
An installed printer icon helps you print files in the same way as the Print
command of the ShowIPrint dialog box (see Opening a Data File in Chapter 5,

Desktop Management.).
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Drag and position the desired files over the printer icon. If you have a printer
properly connected to your system, the information from the file is sent to th,e
printer. (Some files may print only coded or incomplete information.)
After installing a printer icon, use Save Desktop to save the installation. The
next time you switch on your system, the printer icon appears on your desktop.

Install Application
Using Install Application you can:
Link an application to data files with a specified extension. You can then
process those data files directly from a window, instead of opening the
application first.
Select an autoboot status for any application, so whenever you switch on your
computer, the application opens automatically.
Assign a function key to open any application.
Specify what default directory to use for any application. The assigned
default directory takes precedence over the defaults assigned by the Desktop
Configurations.
Specify a full path or a filename for an application. The specification takes
precedence over the defaults assigned by the Desktop Configuration.
Assign arguments to programs.

Arguments
When you open a program file, you are telling the computer to follow the
instructions in that file. The instructions within the program file then take over
and run the show until you exit from the program.

A Guided Tour of the Desktop 4-17

6--8lcran0%0Owner's Atfa:~i.~ai
Sometimes you need to give the program additional information, such as what to
do with a data file. This additional information is called an argument.
Most programs provide ways for the user to input arguments, such as an Open
File command in a word processing program. In fact, if you input the name of an
existing data file in the Arguments line, and you have your input parameters set in
such a way that the program can find the file, the data file will open automatically
when you open the word processing program.
But unless you work on one data file almost exclusively, other options such as
linking an application to a data file type make arguments of this kind clumsy and
unnecessary.
Arguments are used most often with utility programs. These programs often need
complex additional instructions such as a code sequence to determine which part
of RAM will be used to contain the program instructions. Detailed explanations
of the arguments needed, and the correct syntax for those arguments, will be
included in the program's documentation.
When you open the Install Application dialog box, the text insertion cursor is
already on the Arguments line. Simply type in the arguments and press [Return].
Remember to use Save Desktop to save the argument, otherwise it will be erased
when you switch off the computer.

Linking a Document Type to an Application
Normally, the only way you can process a data file is to first open an application
that can work with the type of data contained in the file. Then you can open the
data file from within the application.
If you attempt to open a data file directly from a window, a dialog box displays
informing you that your options are to show or print the file, or cancel the
request. You cannot edit the data in the file.
But you can use Install Application to link a data file type (determined by the
three character file extension) to an application.
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Choose the file type most commonly used by the application. After linking the
application with the document type, the linked application automatically opens
when you open the document.
Note: You must pay particular attention to assigning correct default directories
and parameters to an application when linking a docunler~ttype to alz
application. This is especially true when you open the application from its icon
on the desktop. Refer to the application's documentation for detailed information
on correct default directories aiad parameters.
To use Install Application to link an application to a data file type, follow these
steps:
1. Display the window containing the application you wish to link to a document type.

l
from the Options
Highlight the desired application. Select l n ~ t a l Application
menu. The name of the selected application appears in the Install Application dialog
box.
Note: You catz select more than one application at once for this operatio~z.
Highlight all the applications you ~ ~ i to
s hinstall, then open the Install
Applicatioiz dialog box. After conzpleting the operatioiz on the first selected
applicatiorz, the izanze of the second selected appli,catiorz appears in the
Install Application dialog box.

2. Press [Tab] to move the text insertion cursor to the Document type line. Type in the
three character file extension of the file type you wish to link to the displayed
application.

3. Select the appropriate Application type.

4. Choose a Default Directory and Parameter.
5. Select install to enter the selected settings.
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Note: When installiizg multiple applications, selecting Skip causes Install
Application to skip'over the application identified on the Application ilanze line.
All the current settings are retained.

Selecting a Default Directory
Every program that works with supporting files (e.g., resource files or help files)
needs a way to look for those files. Desktop Configurations tells your computer
which directory should be the default. This is where the program accesses files if
the program assumes that they are not installed.
Using Install Application to assign a default directory to a specific application
overrides the Desktop Configuration's assignment for that application.
You can set the default directory to Top Window, or Application (the directory
in which the program resides).
Some programs do not look for files in any location other than the default
directory. For these programs, select Top Window, and make sure that the
program file and all supporting files are in the top window.

Selecting Parameters
Before an open application can use a data file, it must first find and open the file.
Most programs enable you to search through all existing directories to locate and
open a desired file.
These programs have no preconceived ideas about the location of files. For these
programs you would choose Full Path, so the entire pathname of the file is used
when a file is opened.
Other programs already have pre-existing partial paths. This means that the
program contains a partial pathname that it uses every time the program searches
for a file. A partial pathname consists of the drive identifier, and all applicable
directories. Only the file name and extension is input for the search. All files
must be in the specified directory, or they cannot be located.
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Check your program's documentation to determine the program's default path,
and make sure all of your data files reside in the correct directory.
Always try Full Path first. Then if necessary, experiment with other combinations
until you find one that works with your application.

Installing an Application to Open from a Function Keystroke
You can install any executable file (program) to open from a function key ([Fl]
through [FlO] at the top of the keyboard).
After you assign a function key to a program, you only have to press the assigned
function key to open that program. The assigned key will only open the program
from the desktop. Once you are within an application, the function keys perform
the tasks assigned to them by the application.
To assign a function key to open an application, follow these steps:
1. Highlight the application.

2. Select Install Application from the Options menu.

3. Press [Tab] twice to move the text insertion cursor to the Install as line.
4. Type the number of the function key you wish to assign to the application.

5. Select Install.

Installing an Application to Autoboot or Normal Boot Status
If you mainly use your computer for a single purpose using one specific
application (such as a database, a word processor, or graphics program), it will
save time if you install that application to autoboot. An application installed to
autoboot status will open automatically whenever you switch on your computer.
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Follow these instructions to install an application to autoboot or to return an
application to normal status:

1. Highlight the icon or name of the application you wish to install to autoboot. Select
Install Application from the Options menu. The Install Application dialog box
displays.

2. Select the BOO^ Status: Auto b o x . ( T o restore normal boot status to an
application installed to autoboot, select the Boot Status: Normal box.)

3. Select the appropriate Application type box.
4. Select install or press [Return].
Remember to use Save Desktop to save the selected boot status, otherwise it
will be erased when you switch off the computer.

Install Devices
The Install Devices command installs desktop icons for all hard disk partitions on
all properly configured devices. It also installs a cartridge icon if a cartridge is in
the cartridge slot during startup.
Use the following steps to install devices:

1. From the Options menu select l n ~ t a lDevices.
l
Icons for all configured devices
appear on your desktop. Each icon has a unique drive identifier letter, and each device
icon is labeled DEVICE.

Note: Yolt call change the shape o f y o u r desktop icoils. See Install Icon ilz
this clzapter.

2. Use the mouse to place the desktop icons where you want them to appear.
Select Save Desktop from the Options menu. The Save Desktop Dialog box
displays. Select OK.
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The Save Desktop command saves your desktop configuration in a file called
NEWDESK.INF. This file stores information about which icons have been
installed and the location of each icon on the desktop. See Save Desktop in this
chapter.

Remove Desktop Icon
If you wish to remove an icon from the desktop, follow these steps:

1. Highlight the icon you wish to remove.

2. Select Remove Desktop Icon from the Options menu. The icon disappears from
the desktop.

Note: If the highlighted icorz represents a data or applicatioi?,file,a dialog hos
displays and asks you whether you want to delete the file or just renzove the icon.
Remember, the information stored on the logical drive represented by a removed
hard disk icon is still on the hard disk. To regain access to that information, you
can: reinstall a hard disk icon for that logical drive, or press [Alt] and the drive
letter.

Set Preferences
The Set Preferences option lets you choose from a variety of different screencolor options.TOS automatically detects which modes are compatible with your
monitor, and displays the available choices. TOS will not you select an
incompatible screen-color mode. Set Preferences also lets you select monitor
resolutions, and whether or not you wish to have alert boxes display during copy,
move, delete, and file overwrite operations.
When you select Set Preferences, the Set Preferences dialog box appears.
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The Set Preferences dialog box offers a full range of screen-color options for
several types of monitors. Using the Set Preferences Dialog box allows you to
choose a multitude of screen-colors and resolutions. Proper use of the settings
described below will allow you to get the best display on your monitor.

Number of Colors Lets you choose between several different screen-color
options. When choosing a setting remember that the screen takes longer to redraw
when it displays more screen-colors.
Number of Columns Allows you to set the width of the screen display to 40 or
80 characters.
Double Lines/ Interlace Displays more lines on some displays and provides
interlace on others.
Compatibility Modes Allows you to call up another dialog box which allows
you to select from a list of several different screen resolutions and other options.

Read .INF File
You can have more than one desktop information file on your system, each
containing different information (such as installed desktop icons and their
placement, and all View and Options menu options). The Read .INF File
command allows you to change to a different desktop environment without
having to transfer files or reboot.
The default NEWDESKJNF file is in the root directory drive C. You can name
the alternate desktop information files anything you like, but the three character
extension must be .INF.
With the Read .INF File command, you instruct your Atari computer to read
information from a specified alternate desktop information file.
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Follow these steps to use the Read .INF File command:

1. Select Read .INF File from the Option menu. The Select an INF File dialog box
displays.

2. Display and highlight the alternate desktop information file. Select OK, or press
[Return]. The new information is read into your computer.

Note: If you wish to save the current NEWDESKJNF file before using the
READ.INF command, simply change the name of the cur-rentfile NEWDESK.INF
file. This allows you to sat,e your desktop without losing your current setup.

Desktop Configuration
With the Desktop Configuration dialog box you can set the default directory and
input parameters for all applications, scroll through assigned function keys, and
assign a single keystroke to various menu commands. The Desktop Configuration
dialog box also displays the amount of RAM currently available.
Most applications use the default directory and input parameters displayed in the
Desktop Configuration dialog box. The exceptions are applications that have been
assigned their own specific default directory and input parameters through the
Install Applications dialog box. You can find detailed information regarding
setting the default directory and input parameters under Install Applications in
this chapter.
You can use the Function-keys Assignment to display the full pathname of each
program that has an assigned function key. Use the right and left scroll arrows to
display hidden parts of the pathname, and the up and down arrow keys to scroll
through the assigned function keys.
All menu commands can be assigned a keystroke. This enables you to bypass the
menu bar and initiate the command by pressing a single key.
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Use the Define Single Keystroke up and down arrows to scroll through the menu
commands and their keystroke assignments. To change the keystroke of a
displayed menu command, type in the desired keystroke. To clear all menu
command keystroke assignments, select Clear All.
After making changes to the Desktop Configuration dialog box, select OK to
confirm your choices. Use Save Desktop to save your selections, or they will be
erased the next time you switch off your computer.

Save Desktop
You can rearrange the desktop icons and windows to suit your personal
preferences and use the Save Desktop option to save the new arrangement. For
example, you might want to move the trash can icon, line up the disk icons
horizontally, or have the startup screen display several open directory windows.
Save Desktop also saves Option and View menu selections. The computer stores
saved configurations and menu selections in a NEWDESK.INF file and places
this file on your startup disk or hard disk drive root directory.
Arrange disk and trash can icons by dragging them to new positions on the
desktop. You may want to close all windows first to start with a clean desktop.
How you arrange your desktop will depend on your needs, but it's usually a good
idea to place the trash can icon away from the disk drive icons to protect against
unintentionally dragging files to the trash can instead of to a disk or logical drive
icon.
Arrange directory windows on the desktop by opening, moving, and sizing
selected windows. You can have up to seven directory windows open at once on
the desktop. Select options from the View menu to determine how window items
(folders and files) are shown (as text or as icons) and sorted (by name, date, size,
or type).
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If you show window items as text, you may want to narrow the windows to show
only the item's name and extension.
If you leave the windows open when you save the desktop, those windows will
open to the same size and position the next time you switch on the computer. The
window which is in the foreground when you save the desktop will be the
foreground window the next time you switch on the computer.
The size and position of closed windows is also saved when you select Save
Desktop. The next time you open the window, it will open to the size and
position it occupied on the desktop the last time it was opened.

Desk Accessories
The Control Panel is a desk accessory that comes with your system.
The following section describes the control panel and its uses.

The Control Panel
The Control Panel coordinates many smaller programs called control panel
extensions (CPXs). The initial Control Panel screen displays the names of all
currently loaded CPXs. You can open a CPX by positioning the pointer over the
desired CPX and double clicking.
The Control Panel also contains a drop-down Options menu. When no CPX is
highlighted, the Options menu displays two menu choices: About and Setup. Two
additional Options menu choices display when a CPX name in the main Control
Panel window is highlighted. The three additional options are Open CPX, CPX
Info, and Unload CPX.
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To select an option, position the pointer over the Options menu. Then click the
mouse button. The Options menu displays. Move the pointer until the desired
option highlights. Click the mouse button to select the highlighted option.
Whenever you open a Control Panel or CPX window, you are usually given the
following options: Save, OK, or Cancel. Clicking on the close window box is the
same as selecting OK and then closing the Control Panel.
Selecting Save places the currently displayed setting information in a file on the
startup disk. Your Atari computer reads this file during startup and load in the
saved settings. Select OK if you just wish to change a setting for one session. The
Control Panel window closes, and the changes remain in effect only until you
switch off your computer. The most recently saved settings will be in effect then
next time you switch on the computer.
Selecting Cancel always returns you to the main Control Panel window.

About ...
When you select About, Control Panel information (such as version number and
copyright date) displays.

Setup ...
You can use the Setup dialog box to change a CPX's status (activelinactive),
reload CPXs without restarting your computer, set the amount of memory
reserved for basic CPX information, and designate a CPX directory path. You can
also use the calendar and clock to set the computer's time and date.
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Figure 4-2. The Control Panel

Date and Time
The computer uses the date and time to mark individual files with the date and
time they were created or revised. This feature is useful when you want to
determine which file was most recently changed or created.
You can use 12/24 Hour Time to set the Control Panel clock to 12 or 24 hour
time. This does not affect the way files are dated, only the way the time is
displayed in the Control Panel window. To set the clock or calendar, follow these
steps:

1. Open the Control Panel. Select Date or Time by positioning the pointer over the
desired selection and clicking the mouse button.

2. Press [Left Arrow] to position the cursor in the window, or press [Backspace] or [Esc]
to erase the window. [Backspace] erases the characters in the window one character at
a time. [Esc] erases the entire window.

3. Type in the desired time or date.
4. Click on the new time or date.
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To change between 12 and 24 hour time, position the pointer over the selection
box to the left of the word Time. Click the mouse button. Both the 12 and 24 hour
selection boxes display. Move the pointer until the desired box is highlighted.
Click the mouse button again.

CPX Mover and Reload CPXs
Only active CPXs are loaded during startup. All active CPXs appear in the main
Control Panel Window. If you need to use an inactive CPX, you can use the CPX
Mover to change the status of the CPX from inactive to active. Then when you
select Reload CPXs, the newly active CPX displays in the main Control Panel
window.
You can also remove a CPX from the main Control Panel Window by changing
the status of the CPX from active to inactive.
To change the status of a CPX, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu.

2. Select the CPX Mover. The CPX Mover window appears.

Figure 4-3. The CPX Mover- Window
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3. Select the desired CPX by positioning your pointer over the name of the CPX and clicking.
The CPX highlights, and the appropriate operation appears in the Move box.

Note: You can select multiple CPXs for the move CPXs operation. Use shiftclicking or rubber handing to highlight more than one CPX. If you use rubber
banding, the rxbber band box will not actually appear, hut it still works the
same way.

4. Select the operation by clicking in the Move box.
If you have transferred a CPX from inactive to active status, you must reload before
you can use the CPX. To Reload CPXs, follow these steps:

1. Open the Control Panel. Select Setup from the Options menu.

2. Select Reload CPX. When the confirmation dialog box appears, select OK.

Advanced Setup Options
Setting the Minimum Number of Slots and the CPX Directory Path are advanced
features of the Setup dialog box. You will probably use these options infrequently.

Minimum Number Of Slots
CPXs are stored in an external memory device (hard disk or floppy disk). During
startup or reloading, only basic information about each active CPX (such as the
CPX's name and icon) is loaded into RAM. When you actually open an active CPX,
the bulk of the file is then loaded into RAM so you can use the CPX. When you close
the CPX, the file is erased from RAM until the next time you open it.

Note: CPXs ~ l i t hResident status do not,follow the above pattern, but are copied into
RAM at startup time.
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Your Atari computer has to know how much RAM to reserve for CPX basic
information. When you set the Minimum Number of Slots, you are telling the
computer to reserve enough RAM to be able to store basic information for that
number of CPXs. If the number of active CPXs at startup time exceeds the Minimum
Number of Slots, your computer reserves enough RAM for that number of CPXs. You
can select from 5 to 99 slots.
To change the Minimum Number of Slots, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu.

2. Use the scroll arrows to display the desired number of slots. Select OK or Save.

CPX Directory Path
The CPX Directory Path tells the Control Panel where to look for CPX files. You
probably want to store all of your CPX files in one folder, and set the directory path to
that folder.
But if you store CPX files in more than one place, the CPX Directory Path must be set
to the directory that contains the CPX files you wish to use.
Note: If the CPX Directoiy Path is too long to display in the box, use the left and right
scroll arrows to display the hidden sections of the path.
To change the CPX Directory Path, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu.

2. Click anywhere on the CPX Directory Path box. The File Selector displays.
3. Use the File Selector to select a new path. When you open a directory, the directory name
is added to the File Selector's Directory line. When the desired directory path is displayed,
select OK. The new path appears in the CPX Directory Path box.
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Open CPXs ...
You can open a CPX by first highlighting the CPX on the Control Panel main
window, and then selecting Open CPXs from the Control Panel Options menu. You
can also open a CPX by double clicking on its box in the Control Panel main window.

CPX Info...
When you highlight a CPX and then select CPX Info from the Control Panel Options
menu, the CPX Info window displays. The window contains the selected CPX's
filename, version number, ID number, and Resident/Non Resident status.
Filename is the CPX's actual filename as it appears on the disk. Version and ID are
assigned by the CPX's programmer. Two versions of the same CPX can have the
same ID number. In this case, only the most recent version is loaded.
If you have several versions of the same CPX, you can look at the version number to
determine which is the most recent version.
You can use Configure CPXs (see Configure CPXs in this chapter) to change the
resident status of a CPX. You probably want most of your CPXs to have Resident: No
status. This means the bulk of the program is stored in external memory (hard or
floppy disk) and only read into RAM when you open the CPX.
But if you have a CPX that you use frequently, you may want to give it Resident: Yes
status. CPXs that have a Resident: Yes status on startup are read directly into RAM
and remain there until you switch off the computer. Resident CPXs run a bit more
quickly, but may take up a great deal of RAM.
Note: Whrrl you changc~a CPX's status to Resiciei~t.Yes, the status change cloes izot
take effect until the next time you start your system. The oizly time a CPX can he
installed irito RAM with Resident status is dur.irzg startrq). In the same ~ ' a j changing
,,
a CPX's status to Resiclent: No status does not crctuall~i.emoIse it from RAM uiltil jou
switch off your system.
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Unload CPX ...
Unload CPX does not change the status of the CPX to inactive. It simply removes a
CPX from the CPX list on the Control Panel main window. You can use Reload CPX
to place the CPX back on the list.

Note: You cannot unload a resident CPX.

CPXs
This section provides a general description of the CPXs that come with your
Atari computer. As CPXs are constantly being improved for your benefit, the
descriptions contained in this section may not correspond exactly to the CPXs that
ship with your system.

General Setup
The General Setup CPX allows you to set the keyboard response and repeat rate, the
mouse double click response rate, and the audio feedback. It also allows you to toggle
on and off options, such as CPU Cache, Sound, and BLiTTER and display system
statistics such as the TOS version number and amount of available RAM. Options are
selectable through buttons, sliders, and pop-ups. The General Setup CPX is slightly
different for each system. Following is a description of the General Setup CPX.

Status
Select the Status box to display the TOS version number, version date, and total the
number of available bytes.
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Audio Feedback
The computer has two kinds of audio feedback, a click signaling each keystroke and a
bell signaling keyboard or mouse errors. To control audio feedback, select the keytop
button or the bell button. A gray image means that the sound has been turned off. A
clear image means that sound is turned on.

Chip Select
%

The Chip Select feature allows you to choose among the Blitter and/or Cache options.
Click on the status box below Chip Select. The current selection is indicated in the
pop-up by a checkmark. To change the current selection, move the pointer until the
desired selection highlights, and click on that selection. That setting becomes the
current selection and the pop-up closes. The new setting is displayed inside the
shadowed status box.

Sound
If you want all sound turned off, position the pointer over the Sound button. Click the
mouse button. Move the pointer until the word Off highlights, and click the mouse
button again.

Keyboard Response
Every key on the computer keyboard responds when pressed, and every key (except
[Shift], [Control], [Esc], [Caps Lock] and [Alt]) repeats its character if held down.
The keyboard repeat controls how much time it takes for the keys to repeat when they
are pressed, and how quickly they repeat after the repeat process begins.
The upper slider controls how soon a key starts to repeat. Moving the slider to the left
makes the keys repeat sooner. Drag the slider to the desired position, then release the
mouse button.
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The lower slider controls the speed at which the keys repeat. Move the slider to the
left to make the keys repeat faster. Drag the slider to the desired position, then release
the mouse button.
Test the new settings by turning the sound on, if required, and pressing [Space Bar].
You should hear a click each time you press the space bar. Listen to the clicks to
judge the repetition speed of the keyboard.

Double-Click Response
You can adjust your Atari computer's response to double clicking. To slow the
computer's response to double-clicking, allowing you to double-click more slowly,
select a numbered box nearer to the resting mouse icon. To quicken the com- puter's
response to double-clicking (for fast double-clicks), select a numbered box nearer to
the running mouse icon.
After setting the double-click response, you can test the setting by double-clicking on
the Double-Click Response Test box. When you double-click at the set rate or faster,
the box will briefly highlight.

Modem Setup
The serial port(s) on the computer are type RS232 serial ports. By connecting a
modem to a serial port, you can communicate with other computers. You can also
connect a serial printer or any other RS232 device to the serial port(s).
The Modem Setup CPX lets you configure the computer's serial port(s) to work with
your modem or other serial device. Refer to the manual supplied with your peripheral
for specific information on which parameters to choose. The parameters needed by
the computer with which you are communicating (the remote device) is known as the
communications protocol.
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Serial Port Selector
The Serial Port Selector allows you to tell the computer which of the available serial
ports to recognize as active. Select the port you are using for the connected modem.

Baud Rate
Baud rate is the speed at which data is transmitted. Baud, the standard unit measure of
transmission speed, is the number of signal elements per second. The fastest rate
available to you is 19,200 baud; the slowest is 50 baud. Set the baud rate to
accommodate both your modem and the remote computer's modem. (The baud rate
for bulletin board systems is usually listed along with the phone number for the
board.)
To set the baud rate, position the pointer over the Baud Rate box. Click once and a
pop-up appears. Use the up and down arrows to scroll through the baud rate
selections. When the desired baud rate displays, move the pointer to highlight the
desired rate. Click the mouse button to select the highlighted rate.

Parity
Whenever computers transmit data through telephone lines, there is a chance that
some of the information will become garbled due to imperfections and noise within
the lines. Parity is a error checking procedure that computers use to examine
information and determine whether data was cleanly transmitted.
The parity bit is added to a group of bits to make the total number of bits transmitted
odd or even. Transmission errors can be identified when the number of bits in a group
does not match the parity chosen (odd or even). Depending on the modem and the
remote device, you will choose either None, Odd, or Even parity. (Refer to the manual
supplied with your modem for specific information.)
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To set the parity, position the pointer over the shaded Parity box. Click once and a
pop-up appears. Use the pointer to highlight the desired parity. Click the mouse
button to select the highlighted option.

Each character is stored in memory as one byte. Usually a byte is made up of eight
bits. Depending on bits per character used by the remote device, you may need to
change the number of bits per character when transmitting through the RS232 port.
To set the bitslchar, position the pointer over the shaded BitsIChar box. Click once
and a pop-up appears. Use the pointer to highlight the desired number of bits per
character. Click the mouse button to select the highlighted option.

The stop bit indicates the end of an asynchronous RS232 character. You normally use
1 stop bit, but you may need to use 1.5 or 2 stop bits. To set the number of stop bits,
position the pointer over the shaded Stop Bits box. Click once. Use the pointer to
highlight the desired number of stop bits. Click the mouse button to select the
highlighted option.

Flow Control
You can choose between two flow-control protocols: XonIXoff, and RtsICts. Flow
control protocols are procedures that allow your computer and the remote device to
signal one another when to start or stop sending information. Choose the flow control
supported by the remote modem.
To select a Flow Control protocol, position the pointer over the shaded Flow Control
box. Click once. Use the pointer to highlight the desired flow control protocol. Click
the mouse button to select the highlighted option.
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Printer Setup
Any program may access the printer configurations set by the Printer Setup CPX. For
example, the Print Screen option under the Options menu uses the printer setup
information. Other utilities or applications may not. Check the manuals supplied with
your programs to see if a program can use the printer setup information.
Note: You cannot configure an Atari SLM laser priizter with the lizstall Printer dialog
box. Instead, refer to the Atari SLM Printer User's Manual (supplied with the SLM
laser printer) for instructions on changing printer settings.
If you have both an SLM and dot-matrix or daisy wheel printer connected to your
computer you may be able to select the printer type within your application. If not,
you must turn off one of the printer driver programs.
To configure your printer, display the Printer Setup CPX window. Position your
pointer over the shaded box representing the setting you wish to change. Click the
mouse button. Move the pointer over the desired setting. When the setting highlights,
click the mouse button to select the highlighted setting.

Printer Type
The choices are Dot (dot matrix printers) and Daisy (daisy wheel printers). Select the
appropriate box for your printer.

Color
The choices are B/W (duochrome) and Color. Select the appropriate box for your
printer.
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Only dot matrix graphics printers use the Pixelsbine option. Pixel means picture
element. On dot matrix printers, a pixel is a dot. Dot matrix printers print a certain
number of pixels per line when printing in graphics mode. If you have an Atari dot
matrix graphics printer, select 1280. If you have an Epson, or Epson-compatible dot
matrix graphics printer, select 960. Both values assume an eight-inch printed line.

Quality
Only dot matrix printers use the Quality option. Select Draft for draft-quality printing.
Select Final for letter or near-letter quality printing.
In Draft mode, the printer may make only one pass of the print head when printing.
For darker printing, select Final. Keep in mind that in Final draft mode the printer
generally makes two passes of the print head, thus taking twice as long to print the
page.
Note: D o not select Final if yous printer does not support near-letter quality printing.

Paper
If your printer feeds paper automatically by means of a tractor or single-sheet feeder,
select Feed. If your printer accepts only a sheet at a time which you must insert
manually, select Single. The Single option prevents the printer from printing beyond
the end of a page on documents longer than a single sheet.

Port
If you have a parallel printer, select Printer. Parallel printers connect to the port
marked Printer on the back of the computer. If you use a serial printer, select
Modem. Serial printers connect to the port marked Modem (the RS232 port) on the
back of the computer.

4-40

A Guided Tour of the Desktop

Part I!: Us117gthe Desktop

Note: For most serial printers, XonlXoffflow control is set to On. This setting enables
the printer to signal the computer to temporarily stop sending data so it can print
data it has a l i w d y received. (See RS232 Configuration earlier in this chapter.)

Color Setup
Depending on your monitor type and the screen resolution you have selected, up to
256 colors canbe used for drawing at one time on your screen.
You can choose the colors you wish touse from a palette of available colors.
Note: Not all Atari computers are capable of displaying all the resolutions described
in this sectiorz. Check your system's hardwwre specifications to find out which
resolutions it is capable of displaying.
Color Setup allows you to choose which colors from the color palette you wish to
have available for use when you assign window colors. See Window Colors in this
chapter.
Think of the color palette as a collection of inks. The Color Display Box can display
up to 16 colors at a time (this does not limit the number of colors your system is
capable of displaying).
Modify any pen color according to your personal taste by using the following steps:
1. Select one of the available pens by moving the pointer over the desired pen and clicking the
mouse button.

2. Use the RGB scroll bars to add or subtract a color from the pen. Changing the ratio of Red,
Green, and Blue will change the color of the highlighted pen. Repeat Steps 1 and 2 for
every pen you want to modify.

3. After you modify the color palette, select Save to permanently save the palette, OK to
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select and use the new palette until you switch off the system, Cancel to exit the Color
Setup CPX and return to the Control Panel menu (no changes are saved),
or Reload to display the most recently saved defaults.

Note: If you are setting colors while in the True Color mode, you will notice a
blending effect as you move the R,G, and B control bars. This is normal, because the
True Color mode does not redraw every occurance of a particular. shade, when that
shade is altered.
Note: You can restore the currently displayed color to the condition it was iiz before
you opened it by pressing [UNDO], or selecting reload.

True Color
The True Color mode allows your system to display thousands of colors, whether you
are using an ST, VGA, or television as a display.
True color mode displays such a wide range of colors that some images displayed in
True Color have a near photographic quality.

Sound Setup
The Sound Setup allows you to adjust the volume of the CD quality sound output, and
the microphone input. Use the sliders to adjust the sound output to headphones or
speakers.

Window Colors
Window Colors allows you to assign colors and/or patterns to different elements of
desktop windows, depending on which type of display your system uses.
You can assign colors and/or patterns to each element in all foreground and
background windows.
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Even though the color palette contains thousands of colors, the number of available
colors depends on the selected resolution of the display (on certain models) and
whether the display's output is color or duochrome. Refer to the hardware appendices
for the exact resolution(s) and color(s) your computer is capable of displaying.
You can choose several options (e.g., border, text, and fill) for each window element.
Border allows you to choose the color of the narrow border that sur- rounds each
window element. Use Text to choose the color of any text or icon (as in the case of
the Full box) that appears within the selected window element. Fill is the background
color of the selected element, and you can also choose one of the eight fill patterns
appearing directly under the Fill scroll bar. The fill color appears in the selected
pattern.
The Mode box allows you to toggle between having text appear directly on the fill
pattern, and having text appear within a solid background over the fill pattern. When
you assign element colors to the foreground window and select Save
or OK, the new colors are displayed the next time you open a window. Any window
that is already open does not reflect the new foreground window element colors.
Before you assign window element colors, choose the color set you wish to use. You
can: use the factory assigned default color set, press a function key (1 through 10) to
use a Window Colors preassigned color set, or use Color Setup to create a custorn
color set. Use the following steps to assign foreground and background window
element colors:
1. Select a window element for color assignment. A box outlines the selected element.

2. Click and drag the appropriate scroll box to assign Border, Text, and Fill colors to the
highlighted window element. Click on the desired Fill Pattern.

3. Select the desired Mode. Repeat steps 1 through 4 until all the desired colors have been
selected.

4. Choose Save to permanently save the selected window element colors, OK to select and
use the current colors and/or patterns until you switch off the computer (the next time you
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start the computer, the most recently Saved colors and/or patterns appear., Select Cancel
to exit Window Colors and return to the Control Panel menu (no changes are saved).

Configure CPXs
Configure CPXs allows you to change the name, choose the displayed text and icon
color, and change the RAM resident status of CPXs.
To configure a CPX, you must first display the name of the desired CPX in the name
line. Use the left and right scroll arrows to scroll through the CPX list.
When the Configure CPXs window displays, the text insertion cursor is already
positioned at the end of the CPX Name line.
To change the name of the displayed CPX, press [Esc] to clear the entire Name line,
or press [Backspace] to erase one character at a time.
Then type in the new CPX name.
To select text and icon colors, use the appropriate scroll arrows to display the
available colors and/or patterns. The name and icon shown on the Name line displays
the color or pattern selection.
You can also set the RAM resident status of the selected CPX. Position the pointer
over the shaded RAM resident box and click the mouse button. A pop-up appears.
Move the pointer to highlight the desired status. Click the mouse button to save the
highlighted selection.

When the desired text/icon color selection displays, and the desired RAM resident
status is selected, click on OK or Save.

Note: RAM resident status takes effect otlly at start up time a/?dwhet? you chatzge
resolutions.
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Accelerator
The Accelerator CPX allows you to adjust the speed at which the on-screen pointer
responds to the movement of your mouse. The Accelerator also contains a screen
saver.
There are three mouse Accelerator settings: Off, Fast, and Super Fast. Choose Off if
you do not wish to increase the response speed of the pointer. Select Fast or select
Super Fast to increase the pointer response speed.
To select a new pointer response speed, position the pointer over the desired setting
and click the mouse button.
The Screen Saver automatically darkens the screen after a set period of inactivity. To
activate the Screen Saver, select the Screen Saver box. When the Screen Saver is
active, the Screen Saver Delay slider and the Modem Recognition icon appear as solid
objects on the screen. When the Screen Saver is inactive, the Screen Saver Delay
slider and the Modem Recognition icon appear as outlines.
When the Screen Saver is active, it automatically darkens the screen after a period of
mouse and keyboard inactivity. You can set the number of minutes of inactivity in
two ways. You can use the clock icons on either side of the Screen Saver Delay slider
as scroll arrows, or you can drag the scroll bar. Release the mouse button when the
desired number displays in the scroll bar.
Modem Recognition allows you to choose whether or not you want the Screen Saver
to recognize modem activity. If the Modem Recognition is on, the Screen Saver
recognizes modem activity and will not activate. If the Modem Recognition is off, the
Screen Saver ignores modem activity and activates after the set delay period of
keyboard and mouse activity has passed.

A Guided Tour of the Desktop 4-45

5

Desktop Management

Working with Directories, Folders,
and Files
Directories and folders provide a way to group files together for organization and
storage. Maintaining an organized folder and directory structure helps you locate
files and creates an efficient working environment, both for you and for your
computer.

A collection of information grouped together is called a file. A program or
application file contains instructions for the computer. A data file contains
information to be used or edited by the program or application.

Identifying a Directory, Folder, or File
The root directory is the first directory displayed when you open a disk icon. When
you open a root directory, only the Disk Identifier and file mask appear in the
window's move bar. For example, the move bar of the root directory of drive A
would display the following:

Desktop Management
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When you open a folder, the folder's name is added to the move bar. If you opened
a folder called LETTERS that resided in the root directory of drive A, the move bar
would display the following:

Displaying a Directory or Folder
You can view the contents of a directory or folder by opening the icon, displaying
its contents.
To open a directory or folder, position the pointer over the desired icon, then
double-click the left mouse button or highlight the desired icon and select the
Open command from the File menu. Once the window displays, you can select
other files and folders from the list.
Directories and folders contain data files, program files, and other folders. If you
have a number of related files, you can place them inside one folder to keep them
together. You can also put folders and files within other folders. You can create a
folder using the Create Folder command. (See File Menu, in
Chapter 4, A Guided Tour of the Desktop.)

Files and Filenames
There are two types of files. Executable files (also called programs or applications)
contain instructions for the computer to carry out. Most of the time the instructions
contained in executable files are used to work with information in data files. A data
file is a collection of information that contains no instructions for the computer.
You can place files in root directories and folders. If you choose to display your
folders and files as icons (see View Menu, in Chapter 4, A Guided Tour of the
Desktop.), you will have as many icons in a directory as you have folders and files
in that directory. The name of the file or folder will display under its icon.
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Filenames and Extensions
Files are identified by filenames. You can (must) name the files you create, and you
can change the names of existing files.
The filename is made up of two parts: the name and an optional three-character
extension. In the following example, the name is SAMPLE and the extension is
.PRG.

I I
I extension (optional; a period (.) and up to three characters)
I

name (mandatory; up to eight characters)

The following characters cannot be used within a file name or extension:

Period (.)
Quotation Marks
Forward slash (I)
Back slash (\)
Brackets ([ or
Vertical Break Bar (I )
Less-than Symbol ( c )
Greater-than symbol (>)
Plus Sign (+)
Colon (:)
Semicolon (;)
Comma (,)
Asterisk (*)
Question Mark (?)

I)

Filenames usually refer to the information contained in the file, such as TAXES for
tax information, or TAXES90, TAXES9 1, and TAXES92 for a series of tax
information files.
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Some files must have specific extensions. For example, the .PRG extension tells
your computer that the file is an executable GEM application. If you remove the
extension .PRG from the filename, the computer will not recognize the file as an
application.
Applications often use a specific file extension. This extension is automatically
assigned to any file the application creates. For example, word processors often use
.DOC or .TXT as an extension for documents. See the documentation supplied
with the application for more information.
Each of the following executable file types has a unique file extension by which it
can be recognized. These extensions should be used only for executable files:
.PRG, .TTP, .TOS, .GTP, .ACC, and .APP. Files with any of those extensions
cannot be opened if the extension is deleted or changed.
These six extensions and their definitions are listed below:
.ACC A GEM Desktop accessory. The system accesses .ACC files which appear
under the Desk menu. Use accessories by selecting them from the Desk menu. You
can have up to six active accessories on the system at a time.
.APP A GEM application. An .APP file is a GEM application and will usually
take advantage of the GEM environment by using windows, icons, and drop-down
menus.
.GTP A GEM-Takes-Parameters application (see .TTP)
.PRG GEM application. (See .APP.)

.TOS A TOS application. A .TOS file is a non-GEM application. It does not use
the GEM environment and may not even use the mouse.
.TTP A .TTP (TOS-Takes-Parameters) application. A .TTP file is a .TOS file that
expects some typed parameters (data that will control the program's operation).
When you open a .TTP file, an Open Application dialog box appears requesting you
to enter some parameters. Consult the .TTP program's documentation for more
information.
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Note: When you sort files by type, they are ai.ranged alphabetically by their
extensions.

Pathnames
A pathname tells the computer where to find a file or folder. Pathnames begin with
the appropriate drive identifier, and then list each applicable folder, starting with
the folder residing in the root directory (e.g., A:\ or B:\ etc.) and ending with the
folder that contains the file or folder.
The final element of a pathname is the name and extension of the file or folder. The
move bar displays the complete pathname of the displayed file or folder.
Let's build an example. You have a file in drive A which contains all 1992 sales
and marketing reports for all sales regions. But you are interested in finding the
July 6th sales report from the western sales region.
First you open the disk icon for floppy drive A. A window opens, displaying drive
A's root directory. The move bar displays only the drive identifier and file mask.
The file mask is the *.* following the backslash:

Note: For a full explanation offile masks, please refer to Set File Mask. The
asterisks in the file mask above are known as wild card characters. Wild card
characters are e.wplained in the section on File Specification irz this chapter.
One of the items in the displayed root directory is a folder called SALES. When
that folder is opened, the name of the folder is added to the pathname. The
pathname then consists of the Disk Identifier and the folder name like the example
below:

Desktop Management
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The window now displays the contents of the SALES folder. One of the items in the
displayed directory is a folder called WESTERN. When that folder is opened, the
name of the folder is added to the pathname. Now the pathname looks like this:

In the displayed directory of the WESTERN folder you find the file you are looking
for, called JULY-6.DOC.
If you opened that file from within an application, the following entire pathname
may display in the move bar:

The file mask is replaced by the actual file name and extension.
Note: An underline character separates JULY fr-om 6 . Since the space character is
an illegal character in file or folder names, the underline character is sometimes
used to simulate a space.

Opening a File
When you open a program file, the computer carries out the instructions contained
in the file. This is also called starting or running the program.
There are many ways to open a program file from the desktop. You can position
your pointer over the file's name or icon (located either in a window or on the
desktop) and double-click the left mouse button. You can highlight the file, then:
select the Open option under the File menu, or press the assigned command key
(the default command key for opening a file is [O]). You can also use an assigned
function key to open the program. (See Open under File Menu in the previous
chapter.)
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(Other methods of opening a program file are explained in the Install Application
section under Options menu in the previous chapter.)

File Selector
The File Selector is a special dialog box that can only be accessed from within
a program. You will use the File Selector for loading and saving files. Many
applications programs use the File Selector dialog box (see Figure 5-1).

Directory:

FILE SELECTOR

F:\EASYDRRU\w, GEM

....................

--------,----.m-

------,--a--------a--0---

Figure 5-1. The File Selector Dialog Box
When you display the File Selector dialog box, the Directory field displays the
current directory's pathname. The pathname consists of a disk identifier, folder
name(s), and a file specifier.
The Selection field shows the currently selected file (if one has been selected) and
can be edited like the Directory field.
The directory window shows the current directory's folders and files that can be
accessed by the application. The folders are listed first in the directory window, and
then all files are listed. (For further information on sorting see Sorting Files and
Folders in this chapter.)

Desktop Management
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If the directory contains more files than it can display in the window at one time,
scroll the window to view the hidden files. (See Scrolling a Window, in Chapter
3, The GEM-Desktop.)
The drive selector shows the currently selected drive.
Note: When you make a change within the File Selector dialog box, related fields
automatically show that change. For instance, if you change the drive with the
drive selector, the drive letter in the Directory field also changes.

Selecting A File
Place the pointer on the filename you wish to select. Select a file by one of these
methods:
Click the left mouse button and select O.K.
Double-click the left mouse button.
Enter the filename on the selection field, then select O.K.

Selecting A Directory
From the directory window, open a folder directory by selecting the folder name.
The current directory window's folder appears at the top of the directory, marked
with a folder symbol. To close a folder directory, select the close box button. The
current directory's pathname appears in the Directory Field.
From the directory field, you can select a directory by typing that folder's
pathname. To do this, erase the Directory Field, type the new pathname,and press
[Return]. The pathname contains a disk identifier, and may also contain folder
names and file specifications.
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Selecting a Drive
You can select a drive from the drive selector or the Directory line.
To select a drive with the drive selector, position the pointer over the target drive's
letter. Click the left mouse button to view the drive's directory.

Note: The drive letter is part of the disk drive identifier-, which includes a lettei.
sl~ecifyiizga drive, a colon (:), and a hackslash (\).

The File Specification
The file specification in the Directory field is a search criterion that may include
letters, numbers, and special characters called wildcards (* and ?). The file
specification determines which files appear in the directory window. By editing the
file specification, you can choose which files or types of files to display.
The file specification is similar to a filename. It contains a mandatory name of up to
eight characters and an optional extension of up to three characters. A file
specification uses the asterisk (*) and the question mark characters as wildcards.
An asterisk in a file specification stands for all characters and combinations of
characters, and can replace an entire name or extension. For example, the file
specification *.* calls for the display of all filenames with all extensions.
Often, a file specification has an asterisk for the name, but specifies an extension.
For example, the file specification *.DOC shows all filenames with the .DOC
extension in the directory window. This file specification would not show:

The asterisk must be the last character in the name or extension of a file
specification. For example, the file specification TAX*.DOC is valid, but the file
specification T'"X.DOC is not valid.
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A question mark in a file specification replaces a single character. For example, the
file specification MEMO?.LET specifies all files which begin with MEMO, have
any character in the fifth position of the file's name, and which have the extension
.LET. This file specification would not display the files:

The file specification ????????.??? is equivalent to

*.* .

You can combine wildcards and characters. For example, ?IL*.T?T and F*.T* are
both valid file specifications which would display FILE.TXT.
To change a file specification, edit the specification in the Directory field, then
update the directory window by pressing [Return].

Opening a Data File
You can open the application file first (see Opening a Program File in this
section) and then open the data file using the File Selector. Or you can save a step
by using Install Application to link the data file type (identified by the threecharacter extension) to an application. If the data file type is linked to an
application, you can use one of the four methods for opening a file (see Opening a
Program File in this chapter) as if you are opening the data file from the desktop.
The computer will open the selected file.
Note: You can also open afile by dragging a data file over the icon for the program
file.
If you attempt to open a data file whose file type is not linked to an application, the
Showprint dialog box displays.
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Select Show to display the data file on screen. If the file contains readable text, the
text displays. If the file is longer than one screen, the message -More- appears at the
bottom of each screen of text. You can scroll through the file in the following ways:
O n e screen at a time by pressing [Spacebar] or the left mouse button.
O n e half-screen at a time by pressing [Dl o r [Control] [Dl.
O n e line at a time by pressing [Return].

Note: You can only scroll forward. You cannot scroll hack through text that you
have pr.eviously viewed.
If you press the left mouse button or [Space Bar] while scrolling text by the screen
or half-screen, the screen continues to scroll until it displays a full or half-screen,
beginning from where you last pressed the left mouse button. The End-of-File
message appears when the screen has displayed the entire contents of the file. To
return to the desktop anytime before the End-of-File message appears, press the
right mouse button, [Q], [Control] [C], or [Undo].

File and Fo der Management
Copying, moving, deleting, and other file and folder operations allow you to better
organize your disk space. If you maintain good file and folder organization, you
conserve disk space and create an efficient working environment.

Desktop Management
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Copying Files and Folders
You can copy window items (files and folders) onto a floppy disk, logical drive or
folder.
When you copy a folder, the subdirectory information and all the folder's contents
(files and other folders) are copied to the new location.
To copy a window item, select the item and drag it to its new position on the
desktop. You can drag a window item to another window, disk icon, or folder icon.
The item's destination icon will highlight when the item is positioned on top of the
destination icon.
Note: If you drag a data file on top of an application, the application will run. The
data file will be used as a parameter and will open automatically.
When you begin a copy operation on a single or on multiple window items, the
Copy File(s) dialog box appears. You must select OK to continue the copy
procedure. Working with a single floppy drive, you will need to switch disks
occasionally to complete the procedure. The computer provides alert dialog boxes
to tell you when to switch disks. The Copy File(s) dialog box shows the name of the
destination folder, and displays each item's name as that item is copied.
Note: The Copy File(s) dialog box will not appear if the File Copies confi~matioi?
option has been turned off. See Set Preferences for more information on the File
Copies confirmation option.
You can halt the copy operation by pressing [Undo] while the bee icon displays. On
a single disk drive system, press [Undo] while the source disk is in the drive. When
the Abort Operation dialog box appears, select Yes to halt the operation, or No if
you wish to continue copying.
To copy an entire disk, drag the disk icon to the copy destination (floppy disk,
logical drive, or folder). Copying a disk icon to a folder adds the contents of the
disk to the folder without disturbing the contents of the folder.
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If the destination folder's window is open, copying a file or folder updates the
displayed directory.

Name Conflict During Copying
A name conflict occurs when you attempt to copy a window item to a floppy disk,
logical drive, or folder that already contains an item of the same name. Depending
on the File Overwrites confirmation setting (see Set Preferences in Chapter 4, A
Guided Tour of the Desktop.), the Name Conflict alert dialog box appears,
warning you that a name conflict occurred. If you wish to replace the existing item
with the item of the same name, select Copy.

You could also choose to change the name of the window item you are copying so a
name conflict does not occur when you continue the copy operation.
You can change the item's name from within the Name Conflict alert dialog box.
The text insertion cursor is already positioned at the end of the Copy's Name line.
Press [Backspace] to clear the Copy's Name line one character at a time, or press
[Esc] to clear the entire field. Now type in the new file or folder name and select
Copy or press [Return] to continue the copy operation. The original item remains
intact, and the copied item appears in its destination under the new name. When
copying multiple window items, select Skip if a name conflict occurs and you wish
to skip over that particular item, but you wish to continue the copy operation on the
other selected items.

Moving Files and Folders
Moving a window item allows you to transfer that item to a new location, deleting
the item from its initial location.
To move window items, highlight one or more items. Then hold down [Control] as
you click on and drag the items to a new location. The Move File(s) dialog box
appears, showing you the number of items involved in the Move operation.
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Select OK to complete the move. To cancel the move operation, select Cancel.
When you select OK, the Move Fileis) dialog box shows the destination folder (if
there is one) and the name of the item moved.
You can halt a move operation in progress by pressing [Undo] while the bee icon
displays. When the Abort Operation dialog box appears, select Yes to stop the
operation.

Renaming Files and Folders
You can rename files and folders with the File Information dialog box. The Show.
Information command displays the File Information Dialog Box.
For more complete instructions, (see Show Information, in Chapter 4, A Guided
our of the Desktop). Filenames can have from one to eight characters. Optionally,
filenames are followed by a period and a three-character extension. Folders can
have from one to eight characters, and usually do not have an extension.
Note: As a general rule, you should avoid modifying the three-char.acter extension.
A change in the extension nzay prevent the system or an application fi-onz using
progranz, resource, data, and other files correctly.

Deleting Files and Folders
You can delete unwanted window items to free up room on a disk or in a folder.
There are two ways to delete window items. You can highlight the desired item and
drag it into the trash can icon on the desktop. The trash can icon highlights and the
Delete File(s) dialog box displays. You can also highlight the desired item and
choose Delete Item from the File menu or use an assigned keystroke for Delete.
When the Delete Folders/Items dialog box appears, you can confirm or cancel the
delete operation. To continue the operation and delete the item, select OK.
Note: If the Delete File(s) dialog box does not appear, the File Deletes
corzfirmatiorz option has been turned off. See Set Preferences for more ir7for.mation
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on the File Deletes confirmation option.
You can halt a delete operation in progress by pressing [Undo] while the bee icon
displays. Deleting files is a fast operation, so you must act quickly to halt the
process. When the Abort Operation dialog box appears, select Y e s to stop the
delete operation. This will not retrieve those files already deleted.

Note: You cannot delete afile if its r e a d / ~ ~ ~ stut~rs
. i t e is set at Read Only. Also, you
cannot delete a,folder co~ztaininga Read Only file. To change the readiwrite stat~ls
of a file, select the file, select S h o w lnfo,fi.om the File nzenu, and then sele~,t
ReadIWrite or Read O n i y .

Updating a Directory
Being able to update a displayed directory is useful when you are working with
floppy disks. If you insert a disk into drive A and display that disk's directory, and
then remove that disk and insert a new disk into drive A, the window does not
automatically display the new disk's directory. You can update the directory
displayed in the window by pressing [Esc]. Your computer will read the directory
of the disk that is currently in the drive, and display that directory in the window.
Displayed directories update automatically after you copy, move, or delete a file or
folder, or copy or format a disk.

D e s k t o p Management
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MultiTOS

MultiTOS is Atari's exclusive multitasking environment. A multitasking
environment can run a number of programs simultaneously, which makes it more
powerful and exciting to use than a conventional operating environment (more on
this later). Incorporating a list of features unparalleled by any other operating
system, MultiTOS is a completely new and innovative way of interfacing with your
Atari computer.

The Advantages of MultiTOS
Using MultiTOS, you can use your computer and programs more efficiently. For
example, if you initiate a time-consuming process, such as a file compression
routine, you can run a word processor and type a letter, while the file compression
routine carries on in the background.
MultiTOS has an inherent set of advantages over other multitasking operating
environments. For example, MultiTOS accomplishes true pre-emptive multitasking,
dynamic prioritization, and memory protection.
MultiTOS's pre-emptive multitasking allows your computer to simultaneously run
programs that were not originally designed to multitask. Where other multitasking
environments force the user to manually allocate and reallocate system resources,
MultiTOS dynamically prioritizes system resources for each application.
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MultiTOS's memory protection defines the memory boundaries of each active
program, which keeps one active program from interfering with another active
program's memory.
Using MultiTOS you can easily:
Run multiple programs and desk accessories simultaneously
* Cut and paste information between applications

Move, resize, and scroll background windows without leaving the current
(foreground) application
Monitor the use of system resources by any active program, anytime
Keep track of all the active programs

New Features
MultiTOS offers a host of new features. However, users already familiar with TOS
will find MultiTOS just as easy to use. This section describes the new features
offered by MultiTOS.

Multitasking
The foremost feature of MultiTOS is its ability to run multiple programs
simultaneously. Through memory allocation and memory protection, each program
running under MultiTOS can work concurrently, without using memory designated
for another application.
To provide the most efficient use of system resources, MultiTOS's dynamic
prioritization constantly adjusts the amount of processing time allocated to a
program. For example, if there are many applications running on the desktop,
MultiTOS allocates processing time to allow for all tasks to run.
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MultiTOS use Inter-Process Communications (IPCs), such as messages, pipes, etc.,
to pass information. Applicatons that use the same IPCs can share information with
MultiTOS.

Expanded Desk Menu
One of the first things you'll notice about MultiTOS is its expanded desk menu.
The expanded desk menu not only lists the usual selectable items, but also lists the
desktop and every active program as selectable items. The foreground application is
indicated by a checkmark.

Adoptive Menu Bars
MultiTOS adopts the menu bar of whatever application is running in the
foreground. When the foreground application doesn't have its own menu,
MultiTOS uses the desktop's menu.

Foreground and Background Applications
MultiTOS allows you to have a foreground application and a number of
background applications running simultaneously. The exact number of open
applications depends on the amount available memory. The foreground application
runs in the top window and a background applications run in the bottom windows.
Note: Whichever application is in the foreground receives input from the keyboard.
MultiTOS allows you to choose the top window by selecting or topping it . For
more information on topping see Choosing the Foreground Application later in this
chapter. When you top a window, MultiTOS displays the menu associated with the
foreground application, if that application has its own menu.
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Bottom windows are active, but cannot receive input from the keyboard unless they
are topped. Background processes can run independently, until they need input
from user (see Running an Application in the Background, later in this chapter).
MultiTOS allows you to move, resize, and scroll bottom windows without topping
them.

More Desktop Control
MultiTOS gives yo11 more control over the appearance of the desktop. It allows you
to manipulate windows in the background, as well as the foreground. You can
move, resize, and scroll any window, without changing the foreground application.

Ease of Use
Although MultiTOS is a versatile and powerful multitasking environment, it
maintains the easy-to-use functions established by its predecessor TOS. In case you
need help, MultiTOS contains on-line help menus that contain a wide variety of
information. To access the on-line help, just press [Helpj.

Launching Applications
To launch a program in MultiTOS double-click on an executable program file in a
directory folder, or on the desktop. (You can use variations of this method by
installing the application on the desktop. See Install Application in Chapter 4, A
Guided Tour of the Desktop.) Once you launch a program, you can leave the
program while it is running, and open another program.
MultiTOS allows you to open as many programs as the amount of available RAM
will allow.
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Running an Application

the Foreground

MultiTOS is a versatile operating system which offers several ways to easily
choose which application runs in the foreground.
The Desk menu displays a list, which includes the foreground application
(designated by a checkmark) and every application running in the background. Any
application you select from the Desk menu becomes the new foreground
application.
Selecting an application from the Desk menu is just one way to choose the
foreground application.

Note: You can al~laysaccess the desktop fi-om any applicatioiz by selecting Desktop
in the Desk menu.
Topping a bottom window is another way of changing the foreground application.
When you have multiple windows open on the desktop, topping a bottom window
makes it the new top window , and causes the application responsible for the
window to become the foreground application.

Running an Application in the Background
You will want to run some tasks, such as file compression or any other timeconsuming application, in the background. Tasks that you run in the background
should not require frequent keyboard input, because only the foreground
application can receive input from the keyboard. Many applications after
implementing an initial set of commands run independently of user input, until
they require more user input or finish the task at hand.
To run an application in the background, just launch the application in the
foreground using one of the techniques described earlier. If necessary, enter any
required commands or arguments. Start the process, then choose another
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foreground application. The background process continues until it requires input
from you, or until it is completed.
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APointer Control & Quick Reference
The following table lists mouse functions and keystroke combinations. You may
copy this page and post it near your computer for quick reference.

Action
Move pointer.

Mouse

Function Keystrokes

Roll mouse in desired
direction.

[Alt] any arrow key
moves pointer eight
pixels in the direction
of the arrow.
[Alt] [Shift] any arrow
key moves pointer
one pixel in the
direction of the arrow.

Select item.

Position pointer on
item. Click left mouse
button.

Position pointer on
an item. Press [Alt]
[Insert].

Select and open item.

Position pointer on
item. Double-click
left mouse button.

Position pointer over
item and press [Alt]
[Insert] twice.

Drag item.

Select item. Hold
down left mouse
button. Roll mouse in
desired direction.

Position pointer on
an item. Hold down
the [Alt] [Insert] keys
and use arrow keys
to move the item.

Right button functions.

Click right mouse
button.

Press [Alt]
[Clr Home].
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Advanced Hard Disk Utilities
This appendix contains information about the Atari Advanced Hard Disk Utilities
disk. It applies to both the internal SCSI and external SCSI or ACSI hard disk
drives. The formatting information in Appendix B does not apply to IDE drives,
which are preformatted by the manufacturer.
This disk contains programs and files that allow you to:
Park and Unpark the read write heads
Install or remove the hard disk driver file
Format and partition the hard disk
Erase the contents of a logical drive
Extend the system-wide folder limit
Mark bad sectors on the hard disk
Create an extended partition scheme

Parking and Unparking the
Readwrite Heads
Whenever you move your computer, you should park the hard drive heads to
prevent damage to the hard disk and the data it contains. Parking the hard disk drive
heads moves the readtwrite heads of the drive away from the disk media.
Parked heads cannot damage the disk media during moving or shipping. The Atari
Advanced Hard Disk Utilities include two types of head parking programs.
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One type parks the disk heads of all hard drives connected to your system. The
other parks the disk heads of individual units.

Caution: If you fail to close all hard disk windows before parking the drive
heads you may damage data on your hard disk.

Parking Drive Heads on All Units
To park the hard disk drive heads on all hard disks connected to your system, run
SHIP.PRG froni a floppy disk in drive A.
Note: SHIP.PRG will not park the heads of a Megafile 44 Removable Hard Disk
Drive.
With a directory of the Atari Advanced Hard Disk Utilities disk displaying, follow
these instructions to run SHIP.PRG.
1. Open the HDX folder.

2. Close all other open windows.

3. Run SHIP.PRG
4. Switch off your hard disk units as soon as the desktop appears.
Parking Drive Heads on Selected Units

To park a specific hard drive, you must select a physical unit to be parked. With
your hard disk utilities disk in drive A or B, follow these instructions to park the
heads on individual physical units:
1. Run the HDX program.

2. Close all other open windows.
3. Select the Ship option on the Disk menu.
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4. A dialog box displays, asking you if the hard disk drive to be parked is an ACSI drive
or a SCSI drive. Select the appropriate drive type. Click on OK to continue.

5. When the Select physical unit(s) dialog box appears, select the physical units that are
to have their heads parked. Select OK.

Note: You can select any physical unit connected to your system (formatted
or not). The unit number boxes of connected devices appear shado~jed.

6. An alert box message appears on screen offering you a last chance to cancel the head
parking procedure. Select OK to park the heads.

7. A final alert box appears, instructing you to turn off your hard disk. Select OK and
switch off the power to your disk drive(s).

Note: If you are preparing to move your entire system, svvitch off your computer at
this time.

Unparking the Drive Heads
The next time you start your system the drive heads are automatically unparked.

Installing and Removing the Hard
Disk Driver File
The HINSTALL.PRG program installs or removes the hard disk driver file. The
hard disk driver allows you to start your system from your hard drive.
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Installing the Hard Disk Driver
Display the directory of the HINSTALL folder. Follow these steps to install the
hard disk driver:
1. Run HINSTALL.PRG.

2. Select Install from the File menu.

3. Select a logical drive for the operation. You can only select logical drives that are
highlighted in shadowed boxes. Select OK.
4. From the displayed dialog box, select OK to install the driver, or Cancel to abort the
operation.

Removing the Hard Disk Driver
Display the directory of the HINSTALL folder. Follow these steps to remove the
hard disk driver:

1. Run HINSTALL.PRG.

2. Select Remove from the File menu.

3. Select a logical drive for the operation. You can only select logical drives that are
highlighted in shadowed boxes. Select OK.

4. From the displayed dialog box, select OK to install the driver, or Cancel to abort the
operation.
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Bypassing the Hard Disk Driver
As an alternative to removing the hard disk driver, you can simply bypass the
driver.
To do so, perform a keyboard warm-boot or press the reset button. When the Atari
logo (Fuji) appears, hold down [Alternate] for a few seconds and the system
bypasses the hard disk driver.

Formatting and Partitioning the
Hard Disk
Caution: The HDX Format and Partition options described in this chapter
completely erase all data on your hard disk. Back up all of your valuable files
before proceeding.

Formatting
You will probably never have to reformat your hard disk. The hard disk has already
been formatted at the factory. Formatting the hard disk creates magnetic patterns
called tracks and sectors. The process also marks and logs bad sectors, areas on the
disk with surface damage or other imperfections. Data stored in these areas could
be corrupted or lost. During hard disk operations, the computer avoids sectors
marked and logged as bad.
The formatting process also automatically divides the hard disk into storage areas
called partitions or logical drives.

Advanced Hard Disk Utilities
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If your system contains an internal hard disk, it will be preformatted by Atari.
Formatting erases all information from a disk and prepares the disk to accept data.
You may need to format the hard disk if the factory format becomes erased due to
mishandling or if the hard disk develops bad sectors.
Display the directory of the HDX folder. Follow these instructions to format a hard
disk:

1. Select HDX.PRG. Then select the Format option from the Disk menu.
2. Read the alert message that appears on screen. If necessary, back up all your data
before proceeding. Select OK to continue.

3.

A dialog box displays, asking you if the hard disk drive to be formatted is an ACSI
drive or a SCSI drive. Select the appropriate drive type. Select OK to continue.

4. Select a physical unit (hard disk drive) for formatting. If you are formatting only the
internal hard disk, select UNIT 0. If you are formatting an additional hard disk,
select a unit that corresponds to the hard disk's DIP switch settings. (See your hard
disk drive owner's manual for information about DIP switch settings.) Units in
shadowed boxes are the units that are connected to your system.

4
414 Select The Physical Unit 414

Figure B. 1: The Select Physical Unit Window
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Select OK to continue. A dialog box may appear, displaying a list of hard disk unit
types.

5. Select the hard disk type showing your drive's model name.

6. Select OK to continue.

7. Read the alert message that appears on screen.
Select OK to format the unit. A message appears informing you that formatting is
in progress.
Note: Wlzcn the partitioning message disappears, the formatting operation is
complete.
When the formatting is complete, the Format optjon automatically initiates the
Markbad and Partitioning options. To find out more about these functions, refer to
the sections on Marking Bad Sectors and Partitioning.
The default partition quantity and size is determined by the hard disk drive model.

Partitioning
If your computer contains an internal hard disk drive, it will already be partitioned.
Partitioning a hard disk is a process that divides the disk into sections. Setting a
partition size tells the hard drive how much storage capacity to assign to each
partition. You can use the factory-set partition capacities or change the storage
capacity of each partition to suit your fiie organization needs.
Partitioning divides your physical hard disk into data storage areas called logical
drives. Each logical drive is pre-installed and will automatically appear on your
desktop unless you repartition the disk.
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Partitioning allows you to store and access your data efficiently by allowing you to
group files and folders in different logical drives.
Use the Partition option to create partitions in sizes best suited to your disk storage
needs. The Partition option lets you use an editing menu to set the size of each
partition or select a suggested partitioning scheme without having to reformat your
disk.
Note: When you repartition your hard disk, you must use the Install Devices
command to install desktop icons for the logical drives.

Selecting a Unit to Partition
Display the HDX folder. Follow these instructions to partition a hard disk:

1. Select HDX.PRG from the HDX folder. Then select the Partition option from the
Disk menu.

2. A dialog box displays, asking you if the hard disk drive to be formatted is an ACSI
drive or a SCSI drive. Select the appropriate drive type. Select OK to continue. The
Select a physical unit dialog box displays.

3. Select a physical unit for partitioning. To partition your hard disk, select the unit
number of the device you want to partition. Only units in shadowed boxes can be
selected. Select OK to continue.

4. Select a partitioning scheme.
There are two ways to select a partitioning scheme. You can use the Choose a
Partition Scheme dialog box to choose from preset partitioning schemes. Or you
can use the Edit Partition Scheme dialog box to create a customized partitioning
scheme. The following sections fully describe each method.
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Selecting a Partitioning Scheme
After you select a physical unit for partitioning, the Edit Partition Scheme dialog
box displays.
Use the Edit Part~tionScheme dialog box to create a customized partitioning
scheme. If you wish to select a preset partitioning scheme, click on Menu to display
the Choose a Partition Scheme dialog box.
From the Choose a Partition Scheme dialog box you can click on the Edit box to
return to the Edit Partition Scheme dialog box.

Creating a Customized Partitioning Scheme
The Edit Partition Scheme dialog box displays information about the selected unit's
current partition scheme.

I14 Edit partition scheme of the unit lli
Total

8

of Partition(s1 l 4
Memory Left: 0Mb

#2

pm-m?q

#3

1
p
J
T
J
-

#4

~TiXim4m-q

j a M E N U i l m m m

Figure B.2: The Edit Partition Scheme Dialog Box
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Information lines appear at the top of the dialog box. The Total line displays the
current total number of partitions. The Left line displays the number of megabytes
on your disk that have not yet been assigned to any partition.
Each partition's size is displayed to the right of the partition number in the edit box.
Minimum partition size is 1 megabyte. Maximum partition size is determined by
the capacity of your hard disk. You can allocate all of the memory on your hard
disk to one partition. For example, a 40 megabyte hard disk can have a single
partition containing all 40 megabytes of memory.
Use the scroll bar to scroll through partition boxes. To view the 28 partitions you
can click on the shaded area of the scroll bar to scroll through four partitions at a
time.
Click on the partition box you wish to create or edit. Then click on the up and down
arrows to the right of the partition size box to increase or decrease partition size.
Clicking on an unused box creates a new partition.
Note: There must be available bytes listed on the left line before you can increase
the size of any partition. 1 megabyte or more must appear in the left box before an
unused partition can be activated.
You can select Menu to display the Choose a Partition Scheme dialog box. This
dialog box allows you to choose preselected partitioning schemes.
To return to the most recent partition scheme, select Undo. Selecting OK initiates
the partitioning process.
If you want to return to the HDX.PRG main menu, select Undo,
The Expert option is shaded and cannot be selected unless you have more than four
partitions. You need to use the Expert option only if you plan to use more than one
operating system. If you are planning to use more than one operating system with
the same hard disk, see Extended Partition Schemes.
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Selecting a Preset Partitioning Scheme
The Choose a Partition Scheme dialog box appears when you select Menu from the
Edit Partition Scheme dialog box.

I

Choose a

partition 5rhe.e:

I/

Figure B.3: The Choose Partition Scheme Dialog Box
The Choose a Partition Scheme dialog box provides a list of suggested partitioning
schemes. Select the scheme you want from the list. Select Edit to return to the Edit
Partition Scheme box.
After you select a partitioning scheme, select OK to partition the disk.

trasing the Contents of a Logical
Drive
You can erase all data from a selected logical drive with the Zero option of the
HDX program. Erasing (or zeroing) a logical drive is useful if you want to clear the
drive to make room for new data or if you want to erase damaged data from a
logical drive without reformatting (and thus erasing) the entire hard disk.
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Display a directory of the HDX folder. Follow these steps to erase the contents of a
logical drive.
1. Select HDX.PRG. Then select the Zero option from the Disk menu.
2. Read the alert box that appears on screen. Select OK to continue.

3. Select a drive for zeroing from the Select the Logical Drive dialog box. Select OK to
continue.

4. An alert box appears giving you a final chance to quit the program before proceeding.
Select OK to continue.

Extending the System-wide
Folder Limit
You can run FOLDER100.PRG to extend the number of folders your system
recognizes. Though most users will be able to create as many folders as they wish
without problems, you can still use FOLDR100.PRG to extend the folder limit even
further.
To use this program, display the AUTO folder directory on drive C containing the
FOLDR100.PRG file. Then change the 100 in the filename to any value between
001 and 999 using the Show Info option from the File menu. The value you enter is
the number of folders beyond 40 you can now access. For example, to extend the
limit to 240 folders, you would change the filename to FOLDR240.PRG.
The FOLDR program must be stored in the AUTO folder of the startup disk
(partition C on the hard disk if physical unit 0 is the startup disk).

8-12

Advanced Hard Disk Utilities

The new folder limit takes effect when you reboot your system. During the boot
procedure, a message appears that shows how many extra folders you have
designated and how many bytes of RAM are allocated to the extra folders. Each
folder uses 132 bytes of RAM.

Marking Bad Sectors
Error messages stating that the data on your disk may be damaged might indicate
the presence of bad sectors on your disk. If such error messages frequently appear,
you should check your hard disk for bad sectors. This process identifies and flags
defective areas on the hard disk. Hard disks may develop defective spots after the
drive has been in use. Once these spots have been logged with Markbad, they will
not be used for your hard disk operations.
The Atari Advanced Hard Disk Utilities disk includes two versions of Markbad.
One version is run automatically during the HDX Format option. This version
operates on the entire selected physical unit and erases all data on the disk during
formatting.
The other version operates on the selected logical drive when you run the HDX
Markbad option. This version helps you preserve data by letting you decide
whether or not to erase data containing bad sectors. Both versions of Markbad
display a log of any bad sectors found. The cumulative tally of bad sectors in the
log appears during subsequent Markbad operations.
Note: You can use the HDX Markbad option on hard disks formatted with a
previous version of HDX.
Display the directory of the HDX folder. Follow these steps to mark bad sectors on
selected logical drives:
1. Select HDX.PRG. Then select the Markbad option from the Disk menu.

2. Select a logical drive from the Select the Logical Drive dialog box.

Advanced Hard Disk Utilities
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Select the logical drive
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Figure B.4: The Select Logical Drive Dialog Box
Select OK to continue.

3. While Markbad scans the logical drive for bad sectors, a message appears telling you
that the program is marking bad sectors. If bad sectors are found in a file, select a
course of action for the file from the Logical Drive Markbad dialog box. This box
displays the name of the file, the address location of the bad sector and cluster in the
logical drive, and your choices for a course of action.

Note: The Logical Drive Markbad dialog appears only when Markbadflags bad
sectors in allocated clusters. An allocated cluster is a cluster that has been
assigned to a file.
Select Delete File to erase the file or Skip Over Bad Sector to preserve the
undamaged portions of the file. Select Ignore Bad Sector to leave the file
unchanged. (Select Ignore Bad Sector if you want to examine the file before
taking action.)
If bad sectors are found in a subdirectory file, select a course of action for the
subdirectory from the Logical Drive Markbad box. This box displays the name of
the subdirectory, its address location, and your choices for a course of action.
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4. Select Delete Directory Only to delete the directory structure and save the
deleted directory files to the root directory. All files saved to the root directory will be
named TMPnnnn where nnnn stands for the starting hexadecimal cluster address of
the file. Select Delete Directory And Files to delete the directory structure and
all of its files. Select Ignore Bad Sector if you don't want to take any action at
all.

Note: If a bad sector is found in a lost cluster, an alert box appears giving
you the option of marking the cluster. A lost cluster is a segment of data that
is unaccounted for and inaccessible to the system.

5. When Markbad finishes scanning the disk, a Logical Drive Markbad tally box with the
total count of newly found bad sectors and the count of all previously found bad
sectors appears.

Organizing and Maintaining your
Hard Disk
The larger storage capacity of a hard disk means that careful folder and file
organization is more important than ever. When planning and using your folder
structure, keep the following tips in mind.
Use folder names that describe the types of files in the folders
Limit the number of files in the root directory
Delete unwanted files to free up disk space for new files
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Backing Up the Hard Disk
It is important to frequently back up your hard disk data. Otherwise, accidentally
deleted or damaged files will be lost forever. As a general rule, it is good practice to
back up new or modified files after each session at your computer.
To back up your data, regularly copy important files or folders onto floppy disks
and store them in a safe place. In addition to the copy option, you can use one of the
many hard disk backup programs available through your Atari dealer or Atari user
groups (see Customer Support.)

Optimizer Programs
An optimizer program checks the structure of your hard disk and rearranges files
and free space on the disk. The multiple sectors of each file are grouped together.
Contiguous free space is placed either at the top of the disk (to increase the speed of
writing new files to the disk) or at the bottom of the disk (to increase the speed of
accessing existing files). Back up your data, then use a file optimizer program
regularly to increase the speed and efficiency of your hard disk drive and to reduce
the possibility of data corruption and loss.
Use one of the many hard disk optimizer programs available through your Atari
dealer or Atari user groups (see Customer Support).

Extended Partition Schemes
Creating an extended partition scheme is an option for advanced users. You will
probably never need to use this option in the normal operation of your computer.
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There are four slots on your hard disk that keep track of partition information. You
can fill each slot with a standard partition, and have each partition represented on
your desktop by a logical drive. Or you can fill one of the four slots with an
extended partition to obtain more than four logical drives.
An extended partition is subdivided into more than one partition. This allows you to
have more than one logical drive representing that slot.
Note: To store system startup data the first partition must be a standard partition.
This partition is always assigned to the first slot. You cannot select the first slot to
contain the extended partition. You must use one of the fhree remaining slots to
contain your extended partition.
Supporting MultiTOS as your primary operating system, HDX.PRG will
automatically choose slot number two to contain your extended partition.
However, if you plan to use more than one operating system, it may be useful to
choose the specifics of the partition assignments. Some operating systems will not
recognize an extended partition scheme. The partitions you use with these operating
systems must be standard partitions.
The Expert option of the Edit Partition Scheme dialog box allows you to choose
which slot will contain the extended partition, and which of four slots will contain
standard partitions.
The Select the extended partition scheme dialog box displays the current extended
partition scheme. The Partition section on the left side of the dialog box shows the
partition number, size, and range of each partition.
The Extended Partition Range dialog box on the right side of the dialog box allows
you to choose which slot will contain the extended partition scheme. The Extended
Partition Range dialog box displays each slot's range of partitions.

Advanced Hard Disk Utilities
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All four slots of the Extended Partition Range box contain partition information.
The first slot contains partition one. The second slot contains the extended partition,
which is subdivided as partitions two through eight. The partitions included in the
extended partition are always highlighted. The third slot includes partition nine, and
the fourth slot contains partition ten. Slots one, three and four contain standard
partitions.

Other Advanced Hard Disk Utilities Disk
Files
* HDX.RSC is a GEM resource file used by HDX.PRG.

WINCAP is a text file the includes information used by HDX.PRG.
HINSTALL.RSC is a GEM resource file used by HINSTALL.PRG.
SHDRIVER-RAW is used with HINSTALL.PRG to create
SHDRIVER.SYS, the hard disk driver file that directs your system to start
from a hard disk.
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Troubleshooting and Maintenance

Troubleshooting
If you run into problems while operating your computer, don't panic. You can
probably fix it yourself. This section describes some common problems and
suggests solutions.
Note: The most common and easily fixed problem is failure to switch orz the power
to the computer.. Always check this first before exploring other possibilities.

The Computer Will Not Start Up
If the power light will not come on or the screen stays dark, follow these steps:
1. Shut down the computer and all attached peripherals (e.g., external drives, printer
etc.).

2. Make sure the the power cable is securely fastened.

3. Check your wall socket or power strip by plugging in a desk lamp or appliance.
4. Switch on all peripherals, then start up the Falcon030.

5. Check the contrast adjustments on the monitor. Turn up the adjustment knob if
necessary.
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No Desktop
If the Power LED comes on, the screen brightens, but the desktop does not display,
you may have a bad desk accessory file in your startup disk or folder.
To bypass the desk accessory, warm boot the system (i.e., press [Control] [Alt]
[Delete]) then hold down [Control] for a few seconds after the Atari logo appears
on the screen.
The system warm boots, but bypasses the software (e.g., Auto folder, desk
accessories etc.) Disable the files that are suspect, then try starting up the system
again.

Software Problems
If you have problems with an application, it may be that the software contains
imperfections (bugs). Try clearing the memory by cold booting your system
(pressing [Control], [Alt], [Right Shift], [Delete]). Reopen the application. If this
helps, it may mean the application experienced a momentary failure.
If you still experience problems, make a new working copy of the application from
the original application disk onto a newly formatted floppy disk. Try running the
application from the new copy.
If you are running the application from a hard disk, remove the questionable file
from the hard disk and copy it again from the original application disk back onto
the hard disk. If this works, the problem is probably with the original working copy
of the application file. If none of your disks work properly, you may need to replace
your original application disk.
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You may find that some older programs (especially games) do not run properly
with the Cache option turned on. If you think this may be the problem, make sure
the Cache option is off before running the program.

Bombs
Sometimes applications develop errors that are potentially damaging to the
computer's operating system. When such an error occurs, MultiTOS detects the
error and terminates the program. In most cases, MultiTOS will also clean up the
memory affected by the terminated program, and return to the desktop. However,
during extreme program failures, as a signal to you, MultiTOS displays one or more
bombs across the screen and attempts to recover from the error.
To protect the computer's operating system, immediately perform a keyboard coldboot when you see bombs displayed. If the problem recurs, discontinue using the
program.

The Hard Disk Drive
Some symptoms identify the hard disk drive as the source of the problem. If you
have an external hard disk many problems can be easily remedied using the
Advanced Hard Disk Drive utilities.
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Optional Internal IDE Hard Disk
If your system contains an IDE hard disk, the hard disk will require a different
formatting and partitioning procedure. The internal hard disk is already prepared
for you and should be accessible immediately after starting the system. If the
system cannot recognize the hard disk for some reason, such as a corruption of data,
take the following steps to correct the problem:

Common Problems
Use the following table to identify and correct common hard disk drive problems.
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Problem

Suggested Solution

Hard disk drive icon C does not
appear when you switch on your
system.

If you are starting your system
from a floppy disk drive, make
sure the startup disk contains
AHDI.PRG in the AUTO folder. If
you are starting your system from
the hard disk, AHDI.PRG must be
copied to the AUTO folder on
drive C. If you have AHDI.PRG in
the proper folder and the system
still does not display disk icon C,
you may need to reformat the
drive. (See Formatting in
Appendix B.)
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Problem

Suggested Solution

The system will not start from
the hard disk.

Run the hard disk driver
installation program
(HINSTALL.PRG.) If the
problem continues, the hard disk
should be backed up and
reformatted. (See Internal IDE
Hard Disk in this Chapter.)

An application program will not
start from the hard disk.

The program contains garbled
data or was not designed to start
from a hard disk.
Try starting your system from the
floppy disk drive with a working
copy of the program. Attempt to
run the program from the program
disk. If it still will not run, contact
the program's manufacturer for
more information.

Identifying and Replacing or Erasing
Corrupted Data
If you still have problems, your hard disk may have developed unusable data.
Unusable data appears altered or is unusable. Try erasing individual bad files and
replacing them with valid backups. If replacement is not possible, follow these
steps to try and recover data:
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1. Run the Markbad option of the HDX program on the Atari Advanced Hard Disk
Utilities disk (as described in Marking Bad Sectors) in each logical drive containing
unreadable data. Recover as much data as possible.

2. Back up the data recovered from the logical drive onto floppy disks.

3. Erase all data in the problem logical drive(s) with the Zero option of the HDX
program and run Markbad on the logical drive again.

4. Copy the data you backed up on to the logical drive.
If the main drive (drive C) contains unreadable data, you may not be able to start
your system from the hard disk. Use a working copy of the Atari Advanced Hard
Disk Utilities as a floppy startup disk to start the system. Follow the steps above,
then install the hard disk driver as described in this appendix.

Error Messages
If an error message appears while you run one of the Atari programs from the Atari
Advanced Hard Disk Utilities disk, the problem is usually something easily
remedied. If you aren't sure what to do when an error message appears, read the
message carefully for a suggested solution. If there is no suggested solution, find
the message in the alphabetical list below and try the solution suggested.

Error Message
Bad Sector List is
corrupted!
[OK]
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Program1
Option

HDX
Format
Partition
Zero
Markbad
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Suggested Solution
See message.

Error Message

Program/
Option

Suggested Solution

Cannot create driver
destination!
[OK]

HINSTALL

Your root directory
may be file at full.
You need to delete
data to make room for
the driver file.Or, your
root directory
may be corrupted.
If so, back up as much
data as you can and
reformat the drive.

Cannot find format
parameters for disk type
cdisk type name>
[OK1

HDX

Make sure the original
WINCAP file is on the
disk with HDX.

Cannot find partition
scheme <selected partition
scheme>
[OK1

HDX

This partition scheme
is not a Partition
recognized by HDX.
Make sure you are
using your original
WINCAP file.

Cannot format <selected
unit>! Try checking all
connections and
reformatting.
[OK1

HDX
Format

Warning: Do not
modify the WINCAP
file. Doing so may
destroy the disk. Make
sure your hard disk is
securely connected.
Then reformat the
drive.
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Error Message
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Program1
Option

Suggested Solution

Cannot open drive
source file!
OK1

HINSTALL
Install

Make sure the
SHDRIVER.RAW file
is on the disk with
HINSTALL.PRG.

Cannot partition <selected
unit>! Try reformatting.
[OK1

HDX
Partition

See message.

Cannot read Bad Sector
List from the disk! Try
backing up the disk and
reformatting.
[OK1

HDX
Format
Partition
Zero
Markbad

See message.

Cannot read Boot Sector
from the logical drive. Try
backing up the disk and
reformatting.
[OK1

HDX
Zero
Markbad
HINSTALL
Install

See message.

Cannot read File Allocation
Table from the logical drive!
Try backing up the disk and
reformatting.
[OK1

HDX
Partition
Zero
Markbad

See message.

Cannot read from directory!
Try rerunning Markbad on
this logical drive when the
current Markbad is
completed.
[OKl

HDX
Markbad

See message.
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Error Message

Program1
O~tion

Suggested Solution

Cannot read Root
Directory entries from the
logical drive! Try backing
up the disk and
reformatting.
[OK1

HDX
Markbad

See message.

Cannot read Root Sector
from the disk! Try backing
up the disk and
reformatting.
[O Kl

HDX
Partition
HINSTALL
Install
Remove

See message.

Cannot save any more
files in the root directory!
Deleting the remaining lost
clusters of the subdirectory
will free up disk space.
[OK] [CANCEL]

HDX
Markbad

When the Markbad
option found a bad
sector in a subdirectory, you directed
the program to save
the deleted directory's
files to the root
directory. There is
no more room in the
root directory for the
files. Either select OK
to delete the rest of the
directory's files or
select CANCEL to use
a disk utility that can
recover the directory's
files.

Cannot write Bad Sector
List to the disk! Try
backing up the disk and
reformatting.
[OK]

HDX
Format
Partition
Zero
Markbad

See message.
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Error Message
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Program1
O~tion

Suggested Solution

Cannot write Boot Sector
to the logical drive! Try
backing up the disk and
reformatting
[OK1

HDX
Zero
Install

See message.

Cannot write driver file to
destination!

HINSTALL
Install

HINSTALL cannot
write to the root
directory of the drive.
Try backing up the
hard disk and
reformatting it.

Cannot write Header to the
logical drive! Try backing
up the disk and
reformatting.
[OK1

HDX
Zero

See Message.

Cannot write Root
Directory entries to the
logical drive! Try backing
up the disk and
reformatting.
[OK1

HDX
Markbad

See message.

Cannot write to Directory!
Try rerunning Markbad on
this logical drive when the
current Markbad is
completed.
[OK1

HDX
Markbad

See message.

Driver file does not exist!
[OK1

HINSTALL
Remove

The driver file
SHDRIVERSYS has
not been installed or
is missing.
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Error Message

Program1
Option

Suggested Solution

File Allocation Table is
corrupted! Try backing up
the logical drive and
zeroing.
[OK1

HDX
Markbad

Back up the logical
drive, erase its data
with the HDX Zero
option, run Markbad,
and restore your data.

Format parameters in the
root sector are corrupted!
Please reformat the disk.
[OKl

HDX
Partition

See message.

HDX

The HDX.RSC file is
either missing or
damaged. Copy
the HDX.RSC file
from the original Atari
Advanced Hard Disk
Utilities disk onto your
working copy of the
disk.

No menu items available
for this disk's capacity
[OK1

HDX
Partition

Use the Edit Partition
Scheme dialog box to
set partition sizes.

Not enough system
memory. Cannot continue.
[OKl

HDX
HINSTALL

Reserved sectors are bad!
Try backing up the disk and
reformatting it.
[OK1

HDX
Format
Partition

Your computer's
memory capacity is
too low to run these
programs. You need a
minimum of 512
kilobytes of system
memory.
See message.
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Error Message

Program1
Option

Selected partition scheme
is for a bigger capacity
unit. Please select another
one.
10Kl

HDX
Partition

See message.

Too many bad sectors to
record. Try backing up
the disk and reformatting.
[OK1

HDX
Markbad

See message.

Too many logical drives!
You cannot have more
than 14 logical drives.
[OK]

HDX
Format
Partition

You cannot have more
than 14 logical drives
on your system.
Repartition disks as
necessary.

Unrecognized boot sector!
Either this logical drive's
boot sector is corrupted, or
another utility was used to
partition this disk.
[OK1

HDX
Zero
Markbad

Before you can use
Zero or Markbad, you
must back up your
hard disk (if necessary)
and reformat with HDX
format.

WINCAP file not found!
Cannot continue.

HDX

Copy the WINCAP file
on the Advanced Hard
Disk Utilities disk to the
disk from which you are
running HDX.

[OK]

Your system will have to
reboot when you quit HDX,
for new disk information to
take effect.

HDX
Format
Markbad

1'
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Suggested Solution
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No action required.
Your system will reboot
when you quit HDX, so
the disk parameters
[ you changed can take
effect. Any data in RAM
will be lost.

Preventive Maintenance
To ensure top performance from your Falcon030 computer system, follow the
guidelines in this section.

Caring for the Computer
Avoid dusty or greasy work areas.
Keep all components out of direct sunlight.
Avoid smoking near the computer system.
Always switch off the system before cleaning it. Clean the outside of
components with a soft, slightly damp, lint-free cloth only. Do not use
cleansers, abrasives, or solvents.
To ship or store the system, repack it in the original factory packing
materials.

Caring for Floppy Disks
* Do not insert or remove disks while the floppy drive's busy light is lit.

Keep disks away from sources of magnetism (such as monitors, televisions,
electric motors, and telephones).
Never touch or clean a disk's magnetic recording surface inside, the plastic
casing.

Caring for the Mouse
Your Atari mouse is designed to last through years of use as long as it's handled
properly. Follow these guidelines for mouse care:
* Don't drop the mouse.

Don't let the mouse hang by its tail.
Keep the surface on which you move the mouse smooth and clean.
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Cleaning the Mouse
You'll need to clean the mouse periodically to ensure its proper operation. Follow
the steps below:
Turn the mouse upside down in your hand with its tail pointing toward you.
2.
Place two fingers on the arrows on either side of the roller opening on the
bottom of the mouse. Push down and away from you until the roller panel pops
loose. Remove the panel.

3.
Holding one hand over the mouse, turn the mouse over so the roller drops into
your hand.
4.
Use a soft, clean, dry cloth to wipe the roller clean. DO NOT USE cleaning
fluid or a lint-creating tissue.

Gently blow into the roller housing to get rid of dust.

6.
Replace the roller in its housing. Reinsert the roller panel, then push it down
and backwards until it locks in place.

A Final Note
Your Falcon030 system is designed for low maintenance and high reliability. But
like anything electronic and mechanical, the equipment can break down.
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Troubleshooting and Maintenance

If you experience problems that appear serious, take the computer (or any other
component) to an authorized Atari service center. For the location of the nearest Atari
service center, contact your Atari dealer or Atari Customer Support. (See Appendix F:
Customer Support).
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Falcon030 Specifications
System Architecture

.

CPU: Motorola 68030 operating at 16 MHz
3.84 MIPS performance at 16 MHz
On-chip demand-paged memory management
Separate on-chip 256-byte instruction and data
caches
Independent address and data buses for increased
performance.
Pipelined architecture
BUS: 32-bit data; 32-bit address
FPU: Optional Motorola 6888112 operating at 16
MHz
RAM: I-, 4-, or 14-MB configurations
ROM: 512 KByte internal; 128 KByte external
cartridge

Digital Signal Processor

Motorola 56001 DSP operating at 32 MHz
16 MIPS performance at 32 MHz
32 KWords of zero wait-state RAM
DSP connector allows easy connection of low-cost
19.2K baud faxldata modems, voice-mail systems,
direct-to-disk digital audio recorders, JPEG/MPEG
image compression, etc.

Expansion Bus

Internal direct processor slot for 386SX PC
emulation, DMA coprocessors, etc.
Optional processor socket for other coprocessors

Falcon030 Specifications

D-I

FBIcon030 Qt't'nev's Manual
Sound

Graphics

Eight 16-bit digital audio DMA record and
playback channels with up to 50-kHz sampling
rate.
Stereo 16-bit digital DMA audio output
Stereo 16-bit digital DMA audio input
SDMA sound1DMA coprocessor

Super VGA: 640 x 480 256 colors
True color 16-bit mode: allows display of up to
65,536 colors.
Accepts external video sync signal to allow highquality genlocking
* Overlay mode for easy video titling and special
effects
Optional overscan
262,144 possible colors
a,:
Hardware-assisted horizontal fine scrolling
BLiTTER graphics coprocessor

Standard Ports

*

*
*
*
*
*
*
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SCSI I1 port with Direct Memory Access (DMA)
High-speed LocalTalk-compatible LAN port
Connector for analog RGB color (VGA or ST) or
composite video
RS232C serial port
Bi-directional parallel printer port (also suitable for
image scanners)
Cartridge port (128 KByte capacity)
MIDI IN / MIDI OUT
Stereo microphone input: miniature stereo plug
Stereo audio out: miniature stereo plug
Two 9-pin joystick connectors
Two 15-pin enhanced digitallanalog controller and
light pen connectors

Appendixes
Data Storage

1.44-MB floppy disk drive
MS-DOS format compatible
Optional internal IDE hard drive

User Interface

Standard QWERTY keyboard layout; low-profile,
sculptured ergonomic design
9415 keys; ten function keys; separate numeric and
cursor keypads
Keyboard processor to reduce CPU overhead
Two-button mouse supplied as standard

System Software

Pre-emptive multitasking with adaptive
prioritization (MultiTOS)
Inter-process communication through MultiTOS
messages and pipes
Hierarchical file system with subdirectories and
pathnames
Icon-based graphical user interface with selfexplanatory command functions
On-line help
TOS operating system in ROM
Multiple window user interface with icons and
drop-down menus
NewDesk desktop and extensible Control panel
allows customization by user
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Connector Specifications

DSP Connector
DB26 Female

SCSI Connector

50t

25
SCSI II Female
Pin

Signal
GND
+5v
Not Connected
GND
SCSI 0
SCSI 1
SCSI 2
SCSI 3
SCSl4
SCSI 5
SCSl6
SCSI 7
Parity
GND

- -

l , , n n n - - - - - - -1 nI I m
-- -l

-------

I

l l l l

Pin

1
26

Signal
Not Connected
+5v
Not Connected
GND
ATN
GND
BSY
ACK
RST
MSG
SEL
C/D
REQ
It0
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Serial Port

DB9 Male

Pin

Signal
Carrier Detect
Receive
Transmit
Data Terminal Ready
GND
Data set ready
Request to Send
Clear to Send
Ring Indicator
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Parallel Port

DB25 Female

Pin

Signal
Strobe
Data 0
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7
Acknowledge
Busy
Not Connected
Select
GND
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Monitor Connector

DB19 Male

Pin

Signal
Red
Green

Blue
MonoIOverlay
GND
Red GND
Green GND
Blue GND
Audio out
GND
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Pin

Signal
GND
Composite SyncIVideo
Horizontal Sync
Vertical Sync
External Clock Input
External SYNC Enable
+12v
M1
M0

SCC Connector

-

8-pin Mini DIN Female RS 422

Pin

Signal
Handshake Output (DTR RS 423)
Handshake lnput or External Clock
- Transmit Data
GND
- Received Data
+ Transmitted Data
General-purpose Input
+ Receive
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Enhanced Joystick

DB15 Male

Port A
Pin

Port B
Signal
UP 0
DOWN 0
LT 0
RT 0
PADOY
FlRE 0 1 LIGHT GUN
VCC (+5 VDC)
Not Connected
GND
FlRE 2
UP 2
DOWN 2
LT 2
RT 2
PADOX
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Pin

Signal
UP 1
DOWN 1
LT 1
RT 1
PAD1Y
FlRE 1
VCC
Not Connected
GND
FlRE 3
UP 3
DOWN 3
LT 3
R73
PAD1X

Appendixes

MlDl Port

DIN 5 Female

MlDl OUT
Pin

Signal

1
2
3
4
5

Thru Transmit
GND
Thru Loop Return
Out Transmit
Out Loop Return

MlDl IN
Pin
1
2
3
4
5

Signal
Not Connected
Not Connected
Not Connected
In Receive
In Loop Return
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Customer Support
Atari Corporation welcomes inquiries about your Atari computer products. We also
provide technical assistance. Write to Customer Relations at an address listed
below.
Atari user groups also provide outstanding assistance. To receive a list of Atari user
groups in your area, send a self-addressed, stamped envelope to an address below.
In the United States, write to:
Atari Corporation
Customer Relations
P. 0 . Box 61657
Sunnyvale, CA 94088
In Canada. write to:
Atari (Canada) Corp.
90 Gough Road
Markham, Ontario
Canada L3R 5V5
In the United Kingdom, write to:
Atari Corp. (UK) Ltd.
P. 0. Box 555
Slough
Berkshire SL2 5BZ
Please indicate User Group List, Technical Assistance, or the subject of your letter
on the outside of the envelope.
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Glossary
.ACC The desk accessory extension.
ACSl Atari Computer System Interface. ACSI is a hardware and software control
procedure used to connect devices to the computer's Hard Disk port (DMA
channel).
active window The window on GEM Desktop that is currently available for
desktop operations such as selecting, copying, moving, and deleting items. The
active window is the only window that you can scroll, update, move, or resize.
alert box A dialog box designed to bring something to your attention. Alert dialog
boxes are punctuated with stop signs, question marks, or exclamation points.
.APP An executable GEM program file extension.
application A program written to solve a specific problem or produce a specific
result, and can be executed by a computer. That is, the computer is applied to the
task. (See program.)
back up To make an archive copy of a disk or file. Backing up disks ensures that
information is not lost if the disk is accidentally damaged or erased.
baud The standard unit of transmission speed of data through a modem, calculated
in signaling elements per second.
baud rate The speed at which data are transmitted from one source to another,
usually from one computer through a modem to another computer.
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bee icon The icon displayed on screen whenever the computer,transfers or
retrieves information from the disk drive. You cannot proceed to another action
while the bee icon is on screen.
bit The smallest unit of computer data (a binary digit). Eight bits equal one byte.
(See byte.)
boot Initial system load procedure. If the procedure for loading your system is in
ROM, booting is accomplished by switching on your system. (See coldstart and
warmstart.)
boot disk A disk containing the system files needed to boot a computer.
busy light The light on a disk drive indicating that the drive is reading from or
writing to a disk.
byte A unit of computer data. Each byte consists of eight bits, providing 256
possible values. For example, the letter i'Es stored in memory as one byte. (See bit
and kilobyte.)
cache A special coprocessing circuit found in most Atari TOS computers that
greatly improves the speed operations.
CD-ROM drive A computer-controlled device that reads high-capacity optical
discs and sends the output to the computer.

click T o quickly press and release a mouse button. A click on the left mouse
button selects items on the desktop. (See double-click and shift-click.)
clock/calendar The file-datihg feature built into the computer and set from the
Control Panel.
close box The small box in the upper left corner of an active window, used to
close the current window.
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coldstart Booting the computer by switching the power off and on or pressing
[Control] [Alt] [Right Shift] [Delete]. A coldstart can be initiated while the
computer is running by switching off the power for 10 seconds, then switching it
back on. A coldstart completely initializes the system. (Compare to warmstart.)
configure T o customize the computer system to your preferences by setting
colors, baud rate, confirmation, and so on.
control panel A desk accessory used to alter and set many of the system's
features and options, such as the color palette, mouse and keyboard response, and
the clock/calendar.
copy A command used to duplicate the information in a file, folder, or disk.
current directory The directory currently displayed in a window, as specified by
the pathname in the move bar.
Cursor A marker that appears on the screen to indicate the position of the next
action. Text cursors are usually either a blinking block or a solid vertical line. The
mouse pointer is sometimes called a cursor.
daisywheel printer A type of printer that uses a rotating wheel to impact
characters against a ribbon and onto the paper.
data file A collection of information used by an application. Data file icons look
like sheets of paper with one folded corner.
default A value, option, or setting that the computer automatically selects until
you direct it otherwise. For example, items on the desktop are shown as icons, by
default, unless you change the option in the View menu.
desk accessory An application loaded into memory from the startup disk when
you switch on your computer. Desk accessories can be accessed either directly from
the desktop or from an application that uses the menu bar format. Desk accessory
files are identified by the .ACC extension.

Glossary
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desktop The main screen for the computer. It includes (but is not limited to) the
menu bar, two disk icons, and the trash icon.
destination disk The disk that information is written to during a copy procedure.
dialog box An interactive message box that the computer uses to communicate
with you. To exit a dialog box, you must acknowledge the message or choose an
option.
directory A list of files. (See current directory, root directory, and subdirectory.)
disk drive The most common data storage device. The computer uses the disk
drive to read information from or write information to a disk.
disk identifier The letter in a pathname indicating which disk is in use. The letter
is always followed by a colon (:) and a backslash N.A disk identifier appears by
itself in the move bar of a directory window when the root directory displays.
diskcopy A procedure that duplicates data from one disk to another disk.
DMA port A high-speed peripheral port for attaching a hard disk drive, CD ROM
drive, or other DMA device to the computer. DMA is an acronym for Direct
Mernory Access. (See ACSI.)

document A collection of data you create or modify using an application.
Documents can contain text, graphics, or both. Also called a file. (See file.)
document type See extension.
dot matrix printer A type of printer that forms characters and graphics by
printing small dots.
double-click Two quick clicks on a mouse button. A double-click on the left
mouse button opens a file, disk, or folder.
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double-sided Allowing use of both sides of a disk. A double-sided disk has both
sides of its magnetic media certified as safe for storing data. A double-sided (highdensity) disk can store up to 1,458,176 bytes of data. A double-sided disk drive can
read, write to, and format both single- and double-sided disks. (Compare to singlesided.)
drag To move an item on the desktop. To drag, point the mouse pointer at an item,
press and hold down the left mouse button, and move the mouse. While the item is
being dragged, a ghost outline of the item appears on the desktop.
drop-down menu A list of options that appears below a menu heading when you
touch the menu bar heading with the mouse pointer.
editable text field A dashed line in a dialog box where you can type characters.
expansion connector An internal connector that permits installation of
additional specialized hardware with your computer. The signals provided include a
direct extension of the microprocessor bus.
extension The characters to the right of the period in a filename. Extensions that
represent the file type are mandatory. An extension can have up to three characters
(letters and numbers). Some common extensions are .ACC, .APP, .PRG, .TOS,
.GTP, and .TTP.
file A collection of information that can be stored on a disk or in the computer's
memory.
file selector A dialog box, opened from an application, that lists files and folders.
The File Selector dialog box can be accessed from the application.
file specification The search criteria used in a file selector.
filename The name of a file, made up of a mandatory name and an extension,
separated by a period. (See extension and filename.)

Glossary
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floppy disk A magnetic medium used to store information generated on a
computer. The disk is made of material similar to audio tape.
folder A subdirectory for storing files and other folders. A folder appears as a
folder icon (manila folder) on the desktop, or with a folder symbol (small box) next
to its name when shown as text.
format T o set the circular patterns on a floppy disk that enable it to store
information. Formatting erases all information previously stored on the disk.
full box The small box in the upper right corner of a window, used to change the
size of a window alternately between a smaller screen and a full-screen.
function keys The keys [ F l ] through [FlO] along the top edge of the computer
keyboard. Many applications use these keys to perform special actions.

GEM The portion of TOS that creates and manages all the windows, icons, menus,
and graphics features of the computer. GEM is an acronym for Graphics
Environment Manager.
hard disk A device used to store data on a magnetic surface. A hard disk drive
can store far more data than a floppy disk drive, and can read and write information
many times faster.
hardware The actual physical apparatus of your computer system. (Compare to
software.)
icon A picture on the desktop that represents a disk, file, folder, or procedure. The
disk icon looks like a filing cabinet; the data file icon looks like sheets of paper
with one corner folded; the program file icon looks like a small desktop; the folder
icon looks like a manila folder; the trash icon looks like a trash can; and the bee
icon loolcs like a bee.
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information line The line at the top of a directory window immediately below
the move bar, telling how many bytes are used by the items listed in the directory,
and how many items there are.
initialize To set the computer to its starting configuration.
inputloutput (110) The communication process that takes place between the
computer and a peripheral device such as a disk drive or printer. Input is
information the computer receives (that is, it is sent in); output is information the
computer transmits (that is, it is sent out).
interface An electronic connection that allows communication between the
computer and a peripheral.
kilobyte 1,024 bytes of data. (See Byte.)
laser printer A high-speed, high-resolution printer that electrophotographically
produces an image on paper. The Atari SLM804 is a laser printer.
megabyte 1,024 kilobytes of data. The abbreviation for megabyte is MB. (See
kilobyte.)
memory The internal or external media that the computer uses to store data and
programs. There are two kinds of computer memory: RAM (Random Access
Memory) and ROM (Read-Only Memory). RAM loses its data if the power is
turned off; ROM retains its information whether the computer has power or not.
menu bar A bar at the top of the desktop. When you first start up your system, the
headings on the menu bar are Desk, File, View, and Options. Other application
programs may have different headings in the menu bar.
MIDI A standard interface designed to connect a computer to a number of
electronic musical devices. MIDI is an acronym for Musical Instrument Digital
Interface.

Glossary
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modem A device that enables you to connect your computer directly to telephone
lines in order to establish a communication link with other computers and on-line
information networks. Also, the port on the computer for connecting a modem or
other serial device. Modem is a contraction of MOdulator/DEModulator.
monitor See video display.
mouse A small, hand-manipulated device connected to your computer that
controls the movement of a pointer on the desktop. As you slide the mouse, a small
roller on the bottom tracks the movements. The mouse has two buttons. The left
button is used for most desktop operations. The right button is used with some
applications.
move To move files or folders from their original locations to a different folder
and/or disk.
move bar The bar at the top of an active window. Use the move bar to drag a
window to a new location on the desktop.
MS-DOS Microsoft Disk Operating System. An operating system used with IBM
PCs and compatibles. Floppy disks formatted on your Atari computer are
compatible with PC systems using MS-DOS and 3--inch floppy drives.
MultiTOS Atari's multitasking operating system.
name The identifying name of a file. A name is mandatory and can have up to
eight characters (letters and numbers).
NEWDESK.INF T h e file that holds your customized desktop data.
NEWDESKJNF must be in the root directory of the boot disk in order for the
computer to read it during booting.
option An item in a drop-down menu that enables you to manipulate the desktop
and the elements on it.
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parallel port An interface which accepts the simultaneous transmission of more
than one bit. (See serial port.)
parameter Data given to a program that controls its operation.
pathname The list of items that specifies the path through the subdirectories on
the disk to the current directory. A pathname consists of a disk identifier and a
string of folders separated by backslashes (for example A:\document\text\). It may
also contain a file specification.
peripheral Any external device, such as a disk drive, monitor, or printer, that you
connect to your computer.
pixel A dot on the computer's video display. Pixels are arranged in a grid, and set
to 640 x 400 dots per grid. Pixel is short for picture element.
pointer The small image on the screen that moves when you move the mouse. The
mouse pointer is usually an arrow, but it may change to other shapes such as a bee
icon during certain procedures.
.PRG A GEM application file extension.
program A detailed and explicit set of instructions for accomplishing some
purpose, expressed in a language that can be read by a computer. (See also
Application.)
program file A file that contains an applications program. The program file icon
looks like a small desktop. Double-click the left mouse button on a program file to
execute the program.
prompt Any symbol or message on screen indicating that the computer is awaiting
input from the user.
RAM The part of the computer's memory used to write data to and read data from
a disk. When you work with your computer, the information displayed on the
monitor screen is in RAM. RAM is an acronym for Random Access Memory.
Glossary
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RGB The color signals that the computer produces to create its special color
display. The combinations of different intensities each of red, green, and blue
enable you to create thousands of colors with most Atari TOS computers.
ROM The part of the computer's memory containing the operating system. ROM
never changes, and retains its information with or without power to the computer.
ROM is an acronym for Read-Only Memory.
root directory The first directory displayed when you open a disk. The root
directory is specified by the disk identifier alone (such as A:\).
RS232 An industry-standard connection for serial peripherals. The RS232 port on
the back of the computer is labeled Modem.'This port is sometimes referred to as
the serial port.
scroll Scrolling allows different areas of a window to be displayed. You can scroll
left, right, up, or down.
scroll bar One of two bars that border an active window on the bottom and right
edges. The scroll bars contain the scroll arrows and are shaded if part of the
window's contents cannot be seen. The larger the shaded portion, the greater the
percentage of the window's contents that is hidden from view.
sector A section of a track on a hard or floppy disk. Sectors are usually 128,256,
5 12, or 1024 bytes long. On a floppy disk, the sectors are 5 12 bytes long. (See
track.)
selecting Clicking the left mouse button on an icon, file, or menu option.
Selected icons and files highlight to indicate the selection.
serial port An interface which accepts the transmission of data one bit at a time.
(See parallel port.)
shift-click Clicking with the mouse button while holding down the [Shift] key.
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single-sided Allowing use of one side only of a floppy disk. A single-sided disk
has only one side of its magnetic media certified as safe for storing data. A singlesided disk can store up to 357,376 bytes of data. A single-sided disk drive can read,
write to, and format only single-sided disks, or double-sided disks that have been
formatted as single-sided. (Compare to double-sided.)
size box A small box at the lower right corner of a window, used to change the
window's size or shape.
sizing The process of changing the size or shape of a window.
software The instructions used by your computer to process data. (Compare to
hardware.)
source disk The disk from which information is copied during a Diskcopy
procedure.
startup disk A disk that usually contains desk accessories, applications, and a
desktop configuration (DESKTOPJNF) file. Insert a startup disk in the floppy drive
before the computer is switched on.
subdirectory A directory inside a directory; often called a folder. (See root
directory .)
.TOS The TOS application file extension,
track One of the circular sections of a disk that can store data. Each track is made
up of smaller sections called sectors. (See sector.)
trash can GEM Desktop icon used to permanently delete files or folders from the
desktop.

.TTP The TOS-takes parameters file extension.

Glossary
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video display A device containing a video screen that you and your computer
use to communicate.
warmstart (warm-boot) Rebooting the computer by pressing the Reset button on
the back of the computer or pressing [Control] [Alt] [Delete]. A warmstart only
partially initializes the system. (Compare Coldstart.)
wildcard A question mark (?) or asterisk (*) character used in a file specification
to specify the search criterion. ?'heplaces one character; w'keplaces all characters to
the end of the first name or extension.
window The work area that the computer uses to display files and folders or to
run programs. Multiple windows can be open on the desktop at one time.
write-protect To mechanically prevent a disk from being formatted, erased, or
written to. To write-protect a disk, move the write-protect tab so you can see
through the notch.
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Index
Audio feedback 4-35
Autoboot 4-21 - 4-22
Accelerator CPX 4-45 - 4-46
Active menu options 4- 1
Advanced Setup Options 4-3 1
CPX Info 4-33 - 4-34
Minimum number of slots 4-32
Open CPX
4-33
Unload CPX
4-34
Alphanumeric keys
2-5
Applications
arguments 4- 17 - 4- 18
assigning boot status 4-21 - 4-22
assigning to function key 4-21
foreground/background 6-3
launching (multiTOS) 6-4
linking a document
type 4-18 - 4-19
selecting default directory 4-20
selecting parameter 4-20
Application file 5-1
Arguments 4- 17 - 4- 18
Arrow keys 3-7 - 3-8
Assigning an application to
a function key 4-2 1
Assigning boot status to an
application 4-21 - 4-22
Atari SLM laser printer 4-39

B
Baud rate 4-37
BIT 2-1
Bits per character4-38
Boot status 4-21 - 4-22
Booting
from floppy disk 1-8
from hard disk 1-7
Border color 4-43
Bottom to Top command 4-7
Byte 2-1
4-4
Bytes usedlavailable

C
Cache 4-35
Calendar 4-29
CD-ROM disc 2-3
Changing an icon identifier
and label 4- 16
Close button 3-8
Close Directory command 4-7
Close Top Window command 4-7
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Color display 4-41 - 4-42
true color 4-42
Color printing 4-39
Color set
custom 4-44
preassigned 4-44
Color setup 4-39,4-41 - 4-42
true color 4-42
Colors
window 4-43 - 4-44
Configuring CPXs 4-44
Control panel 4-2,4-29
About 4-29
Advanced Setup
Options 4-31 - 4-32
CPX Mover 4-30 - 4-3 1
date 4-29 - 4-30
Minimum number of slots 4-32
Reload CPXs 4-30 - 4-3 1
Setup 4-29
time 4-29 - 4-30
Control panel extensions
Accelerator 4-45
Color Setup 4-41 - 4-42
Configure CPXs 4-44
General Setup 4-34 - 4-36
Modem Setup 4-37 - 4-38
Printer Setup 4-39 - 4-41
Sound Setup 4-42
Window Colors 4-42 - 4-44
CopyIFormat dialog box 2-8
Copying
name conflict 5- 13
Copying disks 5-12
Copying files 5-1 1 - 5-12
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Copying folders 5-1 1 - 5-12
CPX 4-28,4-34
Accelerator 4-45 - 4-46
Color Setup 4-41 - 4-42
Configure CPXs 4-44
General Setup 4-34 - 4-36
Modem Setup 4-36 - 4-38
Printer Setup 4-39 - 4-41
reloading 4-30 - 4-3 1
Sound Setup 4-42
unloading 4-34
Window Colors 4-42 - 4-44
CPX Directory Path 4-32
Creating a Folder 4-6
Cursor speed 4-45

Data file 5-1
opening 5-10 - 5-1 1
Date 4-29 - 4-30
Delete command 4-6
Deleting files 5-14 - 5-15
Deleting folders 5-14 - 5-15
Desk Accessories 4-27
Control Panel 4-27 - 4-34
Desk menu 4-2
Control Panel option 4-2
Desktop Info option 4-2
Desktop 2-4
arranging 4-25
expanded (multiTOS) 6-3 - 6-4
saving 4-23 - 4-26 - 4-27

Desktop Configuration
command 4-25 - 4-26
Desktop Info 4-2
Directories 5-1 - 5-2, 5-5 - 5-6
root 5- 1
selecting 5-8
updating 5- 15
Disk drives
selecting 5-9
Disks
CD-ROM disc 2-3
copying 5-12
floppy 2-3, 2- 10
floppy, write-protecting 2- 12
floppy, formatting 2-7
hard disk 2-2
Double-click response 4-36
Double-clicking 3-3, 3- 10
Dragging 3-3 - 3-4
Drive icons 2-5
Drive identifier 3- 10

Extensions 5-3 - 5-4
.ACC 5-4
.APP 5-4
.PRG 5-4
.TOS 5-4
.TTP 5-4

Features 1-1 - 1-2
File management 5- 11
File mask 3-8,5-1
File menu 4-3
Bottom to Top option 4-7
Close Directory option 4-7
Close Top Window option 4-7
Create Folder option 4-6
Delete option 4-6
Format Floppy Disk option 4-9
Open option 4-3
Search option 4-5
Select All Items option 4-8
Set File Mask option 4-8 - 4-9
Show Info option 4-4 - 4-6
File Selector 5-7 - 5-8
File Selector dialog box 5-7
File Specification 5-9 - 5-10
Filename extensions 5-3 - 5-4
Filenames 5-2 - 5-4
Files 5-1 - 5-4,5-7 - 5-15
copying 5- 11 - 5- 12
deleting 5-14 - 5-15
moving 5- 13 - 5-14
opening 5-6 - 5-7
renaming 5- 14
selecting 5-8
types 5-2
Fill color 4-43
Fill patterns 4-43
Floppy disk 2-3, 2-7
capacity 2-9
formatting 2-7
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write protecting 2-9
Flow control 4-38
Folder management 5- 11
Folders 5-1 - 5-2,5-11 - 5-15
copying 5-1 1 - 5-12
creating 4-6
deleting 5-14 - 5-15
extending limit B- 13
moving 5-13 - 5-14
renaming 5- 14
Format Floppy Disk command 4-9
Foreground/Background (multiTOS) 6-3,
6-5
Formatting
floppy disk 2-7
hard disk B-5 - B-7
Front panel 1- 11
Function keys 2-6,4-25
assigning application 4-2 1
Fundamentals 2- 1

bad sectors B-13 - B-16
extended partition schemes B- 17 B-19
formatting B-5 - B-7
icons 2-3
optimizing B- 17
organizing B-16 - B-17
partitioning B-8 - B-12
partitions 2-3
Hard disk icons 3-2
Hard disk utilities
bypassing hard disk driver B-5
erasing logical drive B- 12
extending folder limit B- 13
installing hard disk driverB-3 - B-4
marking bad sectors B-13 - B-16
optimizer programs B- 17
parking drive heads B-2 - B-3
parking Readwrite heads B- 1 B-2
removing hard disk drive B-4
unparking drive heads B-2 - B-3
unparking Readwrite heads B- 1 B-2

GEM 2-4
GEM Desktop 2-4
General Setup window 4-34
Graphics Environment Manager 2-4

Hard disk 2-2
advanced utilities B-1 - B-19
backing up B- 17
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Index

Icon
disk 2-5
dragging 3-6
removing 4-23
selecting multiple 3-6
Inactive menu options 4-1
Information line 3-8

Install Application command 4- 17
Install Devices command 4-22 - 4-23
Install Icon command 4- 13 - 4- 16
changing icon identifier
and label 4- 16
Desktop icon 4- 13
Printer icon 4- 16
Window icon 4- 14 - 4- 15

Keyboard 2-5
alphanumeric keys 2-5
arrow keys 3-7 - 3-8
function keys 2-6,4-21,4-25
numeric keypad 2-7
response 4-35
selecting multiple icons 3-4
Keystroke combinations 2-6
dragging with 3-8
selecting with 3-7
Kilobyte 2-1

Laser printer 4-39
Launching applications (multiTOS) 6-4
Left panel 1- 14
Linking a document type to an
application 4- 18 - 4- 19
Logical drive, erasing B-12

Megabyte 2-1
Memory 2- 1
RAM 2-2,4-32
ROM 2-1 - 2-3
storage 2-2
system 2-2
Menu bar 4-1
active options 4- 1
Desk menu 4-2
File menu 4-3
inactive options 4- 1
Options menu 4- 12
View menu 4-9
Modem
flow control 4-38
parity 4-37
selecting serial port 4-37
setting baud rate 4-37
setting bits per character 4-38
stop bits 4-38
Modem setup 4-36 - 4-39
Monitor
adapter block 1-8
connecting 1-8
Mouse 2-5
care and maintenance C- 13
connecting 1-7
double-clicking 2-6
dragging with 2-6
selecting with 2-5 - 2-6
single-clicking 2-6
speed 4-45
Move bar 5-1

Index
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Fadcon638 Owner's Manila/
Moving a CPX 4-30 - 4-3 1
Moving a window 3-12
Moving files 5-13 - 5-14
Moving folders 5- 13 - 5-14
MS-DOS computers
floppy drives 2-7
format compatible 2-7
Multitasking 6- 1
MultiTOS
advantages 6- 1
foregroundtbackground 6-3, 6-5
new features 6-2

Name conflict during copying 5-13
Naming files 5- 14
Naming folders 5-14
Numeric keypad 2-8

Open command 4-3
cartridge icon or file 4-3
data file 4-3
disk icon or folder 4-3
printer icon 4-3
Opening a data file 5-10 - 5-1 1
Opening a file 5-6 - 5-7
Operating system (TOS) 2-4
Options menu 4- 12
Desktop Configuration
option 4-25 - 4-26
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Install Application option 4-17
Install Devices option 4-22 - 4-23
Install Icon option '4-13 - 4-15
Read .INF File option 4-24
Save Desktop option 4-26 - 4-27
Set Preferences option 4-23 - 4-24

Paper 4-40
Parallel printer 4-40
Parity 4-37
Parking
drive heads B-2 - B-3
Read~Writeheads B-1 - B-2
Partitioning hard disk B-8 - B-12
extended partition
schemes B-17 - B-19
Pathnames 5-5 - 5-6
Peripherals, connecting 1-11 - 1-12
Pixels 2-9
Pixels per line 4-40
Power cable 1-6
Print Screen command 4-39
Printer
color 4-39
parallel 4-40
port 4-40
serial 4-40
Printer setup 4-39
color 4-39
paper 4-40
pixels per line 4-40
port 4-40

printer type 4-40
quality 4-40
Program file 5-1

Quality of print 4-40
Quick Reference A- 1

RAM 2-2,4-32
Read .INF File command 4-24
Rear panel 1- 13
Reloading a CPX 4-30 - 4-3 1
Remove Desktop Icon command 4-23
Right panel 1-12
ROM 2-1 - 2-3
Root directory 5-1
Rubber band box 3-5 - 3-6

Save Desktop command 4-23,4-26 - 4-27
Screen display 2-4
Screen saver 4-45
modem recognition 4-45
Scroll bars 3-8 - 3-10
Scrolling a window 3-10 - 3-1 1
SCSI device, connecting 1-9 - 1- 10
Search command 4-5
Select All Items command 4-8

Selecting
default directory 4-20
directory 5-8
disk drive 5-9
file 5-8
icon 3-3
items with shift-click 3-5
multiple icons 3-4
parameter 4-20
with rubber band box 3-5
with rubber band box
and shift-clicking 3-6
Serial port 4-37
Serial printer 4-41
Set Color and Style
command 4- 11 - 4- 12
Set File Mask command 4-8
Set Preferences command 4-23 - 4-24
colors 4-24
columns 4-24
compatibility mode 4-24
double lines 4-24
Set Preferences dialog box 4-24
Setting color 4-41 - 4-42
Setting modem 4-36 - 4-39
Setting printer 4-39 - 4-41
Setting sound 4-42
Setting up the system 1-5
Setting window colors 4-42 - 4-44
Shift-clicking 3-5
Show as Icons command 4- 10
Show as Text command 4- 10
Show Info command 4-4 - 4-6
Bytes available 4-4

Index 7

Bytes used 4-4
Disk Label 4-4
Drive ID 4-4
Number of Files 4-4,4-5
Number of Folders 4-4,4-5
ShowJPrint dialog box 5- 10 - 5- 1 1
Single-clicking 3-3
Size to Fit command 4- 1 1
Sizing a window 3-1 1
SLM laser printer 4-39
Slots
minimum number 4-3 1
Sorting commands 4- 10 - 4- 11
No Sort 4- 1 1
Sort by Date 4- 11
Sort by Type 4- 11
Sound 4-35,4-42
Sound setup 4-42
Sound Setup window 4-43
Starting your system 1-7
Stop bits 4-38
Storage memory 2-2
System memory 2-2
System orientation 1-1 1

Text color 4-43
Time 4-29 - 4-30
Trash Can Icon 4-26
True color 4-42
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Updating a directory
Using a printer icon

5- 15
4-16

View menu 4-9
Set Color and Style 4-1 1 - 4-12
Show as Icons option 4-10
Show as Text option 4-10
Size to Fit option 4-1 1
Sorting options 4-10

Wildcards 5-9 - 5-10
Window Colors setup 4-42 - 4-44
Windows
close button 3-8
closing 3-9, 3-10
drive identifier 3-8
file mask 3-8
information line 3-8
moving 3-12
opening 3-9
scrolling 3- 10 - 3- 11
sizing 3-11
top window 3-11
Workspace, preparing 1-5
Write-protecting floppy disks 2-9
Write-protect tab 2-9
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